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1 About this document
Goal and purpose
The information provided in this technical manual is a summary of the key
procedures and functions required to assemble, install, commission, and service
the FC721 fire control panel system.
The aim of this technical manual is to provide experienced and qualified personnel
with a quick guide to the necessary processes.

Scope
This technical manual is a supplement to the documents provided for the Cerberus
PRO fire detection system FS720 and applies for the following products:
● Fire control panels FC721
The information contained in this document is valid for introduction package IP6.

Target groups
The information in this document is intended for the following target groups:

Target group Activity Qualification
Installation personnel ● Assembles and installs the

product components at the place
of installation.

● Carries out a function check
following installation.

● Has received specialist training in the
area of building installation technology
or electrical installations.

Commissioning personnel ● Configure the product at the
place of installation according to
customer-specific requirements.

● Check the product operability
and release the product for use
by the operator.

● Searches for and corrects
malfunctions.

● Has obtained suitable specialist training
for the function and for the products.

● Has attended the training courses for
commissioning personnel.

Operating personnel ● Carries out procedures to
correctly operate the product.

● No particular basic training is needed.
● Has been instructed by the

commissioning personnel.

Maintenance personnel ● Carries out all maintenance
work.

● Checks that the products are in
perfect working order.

● Searches for and corrects
malfunctions.

● Has obtained suitable specialist training
for the function and for the products.

Source language and reference document
● The source/original language of this document is German (de).
● The reference version of this document is the international version in English.

The international version is not localized.
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Document identification
The document ID is structured as follows:

ID code Examples

ID_ModificationIndex_Language_COUNTRY
-- = multilingual or international

A6V10215123_a_de_DE
A6V10215123_a_en_--
A6V10315123_a_--_--

Date format
The date format in the document corresponds to the recommendation of
international standard ISO 8601 (format YYYY-MM-DD).

Conventions for text marking
Markups
Special markups are shown in this document as follows:

⊳ Requirement for a behavior instruction

1.
2.

Behavior instruction with at least two operation sequences

      – Version, option, or detailed information for a behavior instruction

      ⇨ Intermediate result of a behavior instruction

⇨ End result of a behavior instruction

● Numbered lists and behavior instructions with an operation
sequence

[➙ X] Reference to a page number

'Text' Quotation, reproduced identically
<Key> Identification of keys

> Relation sign and for identification between steps in a sequence,
e.g., 'Menu bar' > 'Help' > 'Help topics'

↑ Text Identification of a glossary entry

Supplementary information and tips

The 'i' symbol identifies supplementary information and tips for an easier way of
working.
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1.1 Applicable documents
Document ID Title

A6V10210355 System description

A6V10210362 Planning

A6V10210390 Mounting / Installation

A6V10210416 Commissioning / Maintenance / Troubleshooting

A6V10210424 Configuration

A6V10229261 List of compatibility

A6V10210368 Product data

1.2 Download center
You can download various types of documents, such as data sheets, installation
instructions, and license texts via the following Internet address:
http://siemens.com/bt/download
κ Enter the document ID in the 'Find by keyword' input box.

You will also find information about search variants and links to mobile
applications (apps) for various systems on the home page.

1.3 Technical terms and abbreviations
You will find details of technical terms and abbreviations in the 'Glossary' chapter.

http://siemens.com/bt/download
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1.4 Revision history
The reference document's modification index applies to all languages into which
the reference document is translated.

The first edition of a language version or a country variant may, for example, have
the modification index 'd' instead of 'a' if the reference document already has this
modification index.

The table below shows this document's revision history:

Version Edition date Brief description

f 2015-12-15 Edition: Introduction Package IP6
New:
Freezing outputs
Enabling frozen outputs
Switching off, Safety during switch-off, Switching on
Glossary entries in the text marked with '↑'
Cyber security disclaimer
Revised:
Referenced documents updated
Connectable C-NET devices updated
LED indicator (internal) FTO2002 replaced by LED module FTO2008, and red
and yellow LED replaced by red/green and yellow LED
Loading data to the 'Station'
Loading configuration from the PC to the 'Station'
Loading configuration from the 'Station' to the PC
Creating a backup of the 'Site' configuration
Information regarding freezing outputs added to chapters 'Loading configuration
from the PC to the 'Station'' and 'Restarting the detector line'
Initializing 'Station'
Switching off the detector line, Switching off a zone
Information on PIN configuration in Engineering Tool added to the 'PIN
administration' chapter
C-NET detector line updated

e 2014-02-10 Information on voltage ranges revised in the chapter 'Configurable inputs/outputs'

d 2013-11-14 Edition: Introduction Package IP5
● Change to date format according to ISO 8601
● C-NET devices added: FDCI723, FDM223-Ex, OOH740-A9-Ex, FDCL221-Ex,

FDA221, FDA241, FDM273
● License key (S1) replaces license key (L1)
CPR replaces CPD: The Construction Products Regulation (CPR 305/2011)
replaces the previous Construction Products Directive (CPD 89/106).

c 2012-06 Edition: Introduction Package IP4
● C-NET devices updated
Revised:
● General commissioning steps
New chapter:
● Chap. 'Connectivity and communication with 'Station'
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Version Edition date Brief description

b 2010-07 Edition for MP3.0 XS
● Amendments to MP3.0
● Amendments to PMI & mainboard FCM2027
● Various minor changes
● Naming amended

a 2009-05 Technical manual FC721

1.5 How displays are represented in the document
With very few exceptions, the fire control panels and fire terminals are displayed in
this document in tables.
Deviations between the original and the table are indicated by means of examples
in the figures below:

Figure 1: Display with window and bar

Main menu
Exit with <C>

Access level 3

Message summary
Functions
Favorites
Topology

(1)
(2)
(3)
(4)

Element search
Event memory
Login/logout
Settings/administration

(5)
(6)
(7)
(8)

Function
On/Off

Function
All

LED
test

Table representation: Display without window

Selecting element category

Zone
Section
Area
Sounder
Physical channel

(1)
(2)
(3)
(4)
(5)

Table representation: 'Select element category' window without bar

The table representation has the following key deviations from the
original:
● Font and representation (not inverted)
● Windows are indicated separately without display background
● No bars to indicate the position and list length
● No frame around selection
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2 Safety

2.1 Safety instructions
The safety notices must be observed in order to protect people and property.
The safety notices in this document contain the following elements:
● Symbol for danger
● Signal word
● Nature and origin of the danger
● Consequences if the danger occurs
● Measures or prohibitions for danger avoidance

Symbol for danger

This is the symbol for danger. It warns of risks of injury.
Follow all measures identified by this symbol to avoid injury or death.

Additional danger symbols
These symbols indicate general dangers, the type of danger or possible
consequences, measures and prohibitions, examples of which are shown in the
following table:

General danger Explosive atmosphere

Voltage/electric shock Laser light

Battery Heat

Signal word
The signal word classifies the danger as defined in the following table:

Signal word Danger level

DANGER DANGER identifies a dangerous situation, which will result directly in death or
serious injury if you do not avoid this situation.

WARNING WARNING identifies a dangerous situation, which may result in death or serious
injury if you do not avoid this situation.

CAUTION CAUTION identifies a dangerous situation, which could result in slight to
moderately serious injury if you do not avoid this situation.

NOTICE NOTICE identifies possible damage to property that may result from non-
observance.
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How risk of injury is presented
Information about the risk of injury is shown as follows:

WARNING

Nature and origin of the danger
Consequences if the danger occurs
● Measures / prohibitions for danger avoidance

How possible damage to property is presented
Information about possible damage to property is shown as follows:

NOTICE
Nature and origin of the danger
Consequences if the danger occurs
● Measures / prohibitions for danger avoidance
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2.2 Safety regulations for the method of operation
National standards, regulations and legislation
Siemens products are developed and produced in compliance with the relevant
European and international safety standards. Should additional national or local
safety standards or legislation concerning the planning, mounting, installation,
operation or disposal of the product apply at the place of operation, then these
must also be taken into account together with the safety regulations in the product
documentation.

Electrical installations

WARNING

Electrical voltage
Electric shock
● Work on electrical installations may only be carried out by qualified

electricians or by instructed persons working under the guidance and
supervision of a qualified electrician, in accordance with the electrotechnical
regulations.

● Wherever possible disconnect products from the power supply when carrying
out commissioning, maintenance or repair work on them.

● Lock volt-free areas to prevent them being switched back on again by mistake.
● Label the connection terminals with external external voltage using a

'DANGER External voltage' sign.
● Route mains connections to products separately and fuse them with their own,

clearly marked fuse.
● Fit an easily accessible disconnecting device in accordance with IEC 60950-1

outside the installation.
● Produce earthing as stated in local safety regulations.

CAUTION

Noncompliance with the following safety regulations
Risk of injury to persons and damage to property
● Compliance with the following regulations is required.

● Specialist electrical engineering knowledge is required for installation.
● Only an expert is permitted to carry out installation work.
Incorrect installation can take safety devices out of operation unbeknown to a
layperson.



Safety
Safety regulations for the method of operation 2

15 | 118
Building Technologies A6V10211100_f_en_--

Fire Safety 2015-12-15

Mounting, installation, commissioning and maintenance
● If you require tools such as a ladder, these must be safe and must be intended

for the work in hand.
● When starting the fire control panel ensure that unstable conditions cannot

arise.
● Ensure that all points listed in the 'Testing the product operability' section below

are observed.
● You may only set controls to normal function when the product operability has

been completely tested and the system has been handed over to the customer.

Testing the product operability
● Prevent the remote transmission from triggering erroneously.
● If testing building installations or activating devices from third-party companies,

you must collaborate with the people appointed.
● The activation of fire control installations for test purposes must not cause

injury to anyone or damage to the building installations. The following
instructions must be observed:
– Use the correct potential for activation; this is generally the potential of the

building installation.
– Only check controls up to the interface (relay with blocking option).
– Make sure that only the controls to be tested are activated.

● Inform people before testing the alarm devices and allow for possible panic
responses.

● Inform people about any noise or mist which may be produced.
● Before testing the remote transmission, inform the corresponding alarm and

fault signal receiving stations.

Modifications to the system design and the products
Modifications to the system and to individual products may lead to faults,
malfunctioning and safety risks. Written confirmation must be obtained from
Siemens and the corresponding safety bodies for modifications or additions.

Modules and spare parts
● Components and spare parts must comply with the technical specifications

defined by Siemens. Only use products specified or recommended by
Siemens.

● Only use fuses with the specified fuse characteristics.
● Wrong battery types and improper battery changing lead to a risk of explosion.

Only use the same battery type or an equivalent battery type recommended by
Siemens.

● Batteries must be disposed of in an environmentally friendly manner. Observe
national guidelines and regulations.

Disregard of the safety regulations
Before they are delivered, Siemens products are tested to ensure they function
correctly when used properly. Siemens disclaims all liability for damage or injuries
caused by the incorrect application of the instructions or the disregard of danger
warnings contained in the documentation. This applies in particular to the following
damage:
● Personal injuries or damage to property caused by improper use and incorrect

application
● Personal injuries or damage to property caused by disregarding safety

instructions in the documentation or on the product
● Personal injury or damage to property caused by poor maintenance or lack of

maintenance
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2.3 Standards and directives complied with
A list of the standards and directives complied with is available from your Siemens
contact.

2.4 Release Notes
Limitations to the configuration or use of devices in a fire detection installation with
a particular firmware version are possible.

WARNING

Limited or non-existent fire detection
Personal injury and damage to property in the event of a fire.
● Read the 'Release Notes' before you plan and/or configure a fire detection

installation.
● Read the 'Release Notes' before you carry out a firmware update to a fire

detection installation.

NOTICE
Incorrect planning and/or configuration
Important standards and specifications are not satisfied.
Fire detection installation is not accepted for commissioning.
Additional expense resulting from necessary new planning and/or configuration.
● Read the 'Release Notes' before you plan and/or configure a fire detection

installation.
● Read the 'Release Notes' before you carry out a firmware update to a fire

detection installation.

2.5 Cyber security disclaimer
Products, solutions and services from Siemens include security functions to ensure
the secure operation of building automation and control, fire safety, security
management, and physical security systems. The security functions on these
products, solutions and services are important components of a comprehensive
security concept. Drafting, implementing and managing a comprehensive and up-
to-date security concept, customized to individual needs, is nevertheless
necessary, and may result in additional plant- or site-specific preventive measures
to ensure secure operation of your site regarding building automation and control,
fire safety, security management, and physical security. These measures may
include, for example, separating networks, physically protecting system
components, user training, multi-level defensive measures, etc. For additional
information on security as part of building technology and our product, solution and
service offerings, please contact your Siemens sales representative or project
department. We strongly recommend to always comply with our security advisories
on the latest security threats, patches and other related measures.

http://www.siemens.com/cert/en/cert-security-advisories.htm
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3 System overview
Cerberus PRO fire control panels FC721 are operated as standalone control
panels. FC721 fire control panels cannot be networked with one another or with
other FS720 fire control panels.
Cerberus PRO fire control panels FC721 support operation of the CNET detector
line as a loop or stub. Automatic fire detectors, manual call points, I/O components,
transponders and other C-NET users are connected to a C-NET detector line.

Figure 2: System overview of the fire control panel FC721

1 Fire control panels FC721
2 C-NET detector line
3 Periphery (e.g. RT alarm transmission installation or acoustic signal

transmitter etc.)
4 PC with the 'Cerberus-Engineering-Tool' FXS7212 software for

commissioning and configuration

Properties
● Integrated operating unit
● Integrated line card for C-NET detector line
● Integrated power supply 70 W
● Optional power supply 70 W or 150 W in separate empty housing

C-Net

1

4

Synoptic

2

3

C

CerberusTM
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3.1 Station types
Overview of the fire control panel FC721 and options

FC721 in housing (Eco)

FC721-ZZ FC721-YZ FC721-HZ

Standard operating unit Operating unit with integrated LED
indicator (24 indicator groups, each
with a red/green and yellow LED)

Operating unit with integrated
EVAC-NL operating unit according

to the requirements for the
Netherlands

1 loop or 2 stubs
Power supply (70 W)

Installable batteries max. 2x 7 Ah
Housing (Eco), 430 x 398 x 103 mm (W x H x D)

Additional empty housing External printer More options
● Serial RS232 module for

external printer
● Serial RS485 module
● License key (S1) for display and

operation on PC
● Key switch (Kaba or Nordic)
● 19" mounting kit

FH2002-A1 DL3750+

Housing (Standard)
430 x 398 x 160 mm (W x H x D)

Dot matrix printer (external) to
RS232 interface

● For additional power supply
(70 W or 150 W)

● Batteries up to 2x 26 Ah

● RS232 module not within the
scope of delivery (option)

C

CerberusTM

C

CerberusTM

C

CerberusTM
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4 Planning

4.1 FC721 system limits and options
FC721 System limits

Detector line

Max. C-NET addresses 126 *(1 loop or 2 stubs)

Number of loops or stubs 1 loop or 2 stubs

Number of devices per loop Max. 126

Number of devices per stub line Max. 32

Supply

Power supply 70 W

Batteries (with 70 W power unit) Max. 2x 7 Ah

Battery extension (optional) Max. 2x 26 Ah
with optional power supply (150 W) and additional

empty housing (standard)
External DC 24 V supply ―

Operating unit Integrated

Inputs and outputs

RT alarm, relay 1

RT fault, relay 1

RT alarm monitored 1

RT fault monitored 1

Outputs for monitored, acoustic signal transmitter 1

Freely configurable inputs/outputs 4

Options

RS232/RS485 module Max. 1

Ext. Printer DL3750+ Max. 1

LED module; 24 red/green and yellow LEDs each Max. 1

EVAC-NL operating unit [NL] Max. 1

License key S1 Max. 1

Kaba or Nordic key switch Max. 1

* Note system limits!
The description of system components and options does not form part of this
technical manual.
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4.2 Functions
This chapter describes the most important functions that can be supported by the
fire detection system.

Decision on alarm
The danger signals of the detectors are evaluated by the zone. The decision on
alarm is made at zone level. Decision on alarm can be configured as follows for
each zone:
● Single-detector dependency

– The first detector in the zone which detects the corresponding danger level,
triggers a fire alarm.

● Multi-detector dependency
– The danger levels of several detectors are included in the alarm decision

(e.g. two detectors reporting danger level 3).

Alarm verification concept for delayed alarm transmission
The alarm verification concept (AVC) serves for delayed alarm transmission. The
operating personnel are integrated into the alarming process. During the time (t1)
for monitoring attendance, a check is run to establish whether operating personnel
are present. The operating personnel can examine the fire location during the
investigation time (t2) and can prevent the alerting of the fire brigade in case of
false alarm.
This behavior is only applicable in operation mode 'Manned'.
In operation mode 'Unmanned', the alarm transmission is activated immediately.

An attendance check delay (t1) can be configured for each fire control panel. The
investigation time (t2) can be defined by zone.

Controls
Universal controls can be configured to automatically actuate the appropriate
controls in the event of an alarm. Any events (e.g. alarm or isolation) are linked
logically (OR, AND, NOT) to activate the controls (e.g. the closing of fire doors).

Evacuation
To ensure a controlled evacuation of people from the building in the event of fire, it
is possible to configure chronological alarming in different building sections.

Remote access
The Cerberus Remote Operating Tool provides a PC-based PMI for remote access
to the fire detection system. Remote access to the fire detection system is possible
with the Cerberus Remote Tool. Cerberus Remote is connected to the Ethernet
port of a station.
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4.2.1 Defining controls
Connections for controls are available on the following components / control
panels:
● Fire control panels FC721
● Input module FDCI221
● Input module FDCI222
● Input/output module FDCIO222
● Input/output module FDCIO222
● Input/output module FDCIO223
● Input/output module FDCIO224
● Addressable alarm indicator FDCAI224
The table below shows the control outputs available for the different hardware
modules.

FC721 FDCI221 FDCI222 FDCIO221 FDCIO223 FDCIO222/
FDCIO224

RT alarm (relay) 1 – – – – –

Alarm output (monitored) 1 – – – – –

RT fault (relay) 1 – – – – –

Alarm output (monitored) 1 – – – – –

Monitored horn lines 1 – – 1 2 –

Monitored contact inputs – 1 4 1 – 4

Non-monitored control
outputs/contact inputs

4 freely
configurable

I/Os

– – – – 4 outputs

Table 1: Control outputs in the fire detection system

Notes
● The outputs can be used for any controls. Any events, commands and signal

inputs can be linked as an OR, AND and NOT relation.
● Controls can be configured system-wide. This means that the causes can

come from any point in the system.
● The controls can be configured as activated or deactivated with a delay in a

range of 0…30 minutes.
● The onboard inputs/outputs in the fire control panel may be configured as

inputs or outputs.
● If an onboard input/output is configured as an input in the fire control panel, it is

activated by applying 0 V.
● If an onboard input/output is configured as an output in the fire control panel, it

switches 0 V when active (open drain).
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5 Mounting

5.1 Mounting and assembling a station
Before mounting and installation, check all the fire detection installation
components visually for damage caused by improper transport.

Figure 3: Unpacking and checking
● Components with clear signs of damage must not be used in the station or

operated as fire detection installation components.
● National and local standards and requirements must be observed when

assembling the station and its components.
● The following mounting instructions refer to the specifications of the EN 54

standard and the manufacturer's recommendations.
● The site chosen to assemble the station and associated components must

match the planning documents for the fire detection installation.

C

CerberusTM
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5.2 Mounting instructions
The station's product insert contains an mounting model to assist with mounting.
The dimensions needed and details of the mounting points are shown on the
mounting model. Details on mounting and installation can be found in the reference
documents.
● The station must be assembled in a dry, clean and well vented room.
● The station must be assembled at a distance of at least 1m from the room's

entrance and/or any moving parts.
● The height of mounting must be such that the display and optical indications

are approx. 1.6 -1.7m above where the observer stands.
● The station and its components must be protected from dampness and

interfering external influences such as dust, great temperature fluctuations and
mechanical stress.

● The station must be assembled in a place freely accessible to authorized staff
and the emergency services.

● The station must be fitted to a level, non-vibrating wall surface with load
bearing capacity using suitable mounting materials (e.g. screws and plugs).

● The mounting surface and selected mounting must be suitable for the weight of
the equipped station incl. the batteries used.

● The station may only be fitted using the 19" method if using the associated
components.

● Mounting is not permitted in rooms with high levels of electromagnetic
interference, e.g. in control rooms or right next to power cables and inductive
loads.

WARNING

Voltage
Electric shock
● Mounting and installation work may only be undertaken by qualified staff and

when the system is de-energized.

WARNING

Thermal bridge between station and mounting surface
Risk of fire, for example due to the batteries overheating
● If the station is mounted on a flammable wall, all cut-out sections for the

mounting holes must be sealed using the supplied aluminium path taps.

NOTICE
Electrostatics
Damage to electronics
● Suitable protective measures must be taken when working with electronics

modules.
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5.2.1 Surface-mounted assembly
● Any surface irregularities can be compensated with washers or wooden

wedges.
● The rear panel is attached to the wall using screws with a diameter of 6 mm.
● The supplied edge protection strip must be placed around rectangular breakout

openings.
● Depending on the cable type, up to 8 cables can be fed through each round

opening (20 mm with rubber grommet).
● Only one cable may be fed through each screwed cable gland (not within the

scope of delivery).

Mounting steps
1. Break out the required cable openings on the rear panel.

Signal and control cables must be fed into the housing from above or from the
rear (EMC protection).

2. Screw in the cable gland for the power cable (Ø 20 mm), or insert a rubber
grommet.

3. Mark the bore holes for the dowels using the supplied drilling template. The
cardboard cover in the packaging is also the drilling template. The holes in the
cardboard cover correspond to the mounting holes in the rear panel.
The holes can also be marked using the information in the product insert.

4. Drill the holes and insert the supplied dowels.

5. Attach the housing using the supplied screws.

6. Stick the supplied aluminium stickers over all holes for wall mounting.

7. Feed the mains cable into the housing and fix the cable with cable ties.

8. Protect the electronics if necessary using the cover of the packaging or other
suitable means.

9. Regarding the mounting location of the FC721, please adhere to the
instructions in this chapter.
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Figure 4: Mounting of the FC721

1 Recommended display height approx. 1.6 to 1.7 m
2 Width of the FC721: 430 mm
3 Distance from door of at least one door leaf width
4 Height of the FC721:

● 398 mm
● Plus additional housing (Standard) = 796 mm

C

Cerberus
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2 3
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Assembling the FC721 and additional housing (option)
The FC721 is supplied inside the Eco housing.
An additional empty housing (Standard) can be assembled and connected for a
larger battery capacity. This has space for an additional 150 W power supply and
larger batteries. The additional housing is mounted directly below the FC721 and is
screwed onto it.
The empty housing (Standard) consists of the following components:
● Rear panel
● Operator unit (empty)
● Cover cap

Figure 5: Assembling the FC721 and additional housing (option)

1 FC721 with the 3 mounting points
2 Cable entries
3 Additional empty housing (Standard)(empty) for optional power supply

(150 W)
4 Mounting points for wall mounting
5 Holes for housing assembly
6 Break-outs for cable entry
7 Break-out holes for cable entry

X8 X7 X6 X11

X3X400

X1
X3

X8

4

5

5

3

1

2

6

7
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Mounting steps
1. Break out the required openings for feeding the cables at the bottom of the

FC721 and the mounting holes for assembling the housing.

2. Break out the required openings for feeding cables and the mounting holes for
housing assembly at the top on the rear panel of the extra housing.

3. Attach edge protection strips or rubber grommets at the openings for the
cables.

4. Fasten the rear panel of the additional housing in the same way as for the
FC721. Make sure that the alignment is exact.

5. Stick the supplied aluminium stickers over all holes for wall mounting.

6. Attach the two housings to one another by putting screws through the mounting
holes in the bottom and the cover.
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5.2.2 Mounting and wiring the operating unit

From IP5, the PMI & mainboard FCM2027 is used. You will find detailed
information in document A6V10210368.

Figure 6: View of an FC721 with open operating unit

1 Connection (X3) for the ribbon cable on the periphery board
2 Hinge
3 Cable routing to the optional components
4 Cable ties for fixing the cables
5 Operating unit
6 Holes for securing the operating unit
7 Connection (X3) for the ribbon cable on the PMI & mainboard
8 Ribbon cable from the periphery board to the PMI & mainboard
9 Plastic clip for securing the ribbon cable

2

1

6

3

7

9 8

4 5
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Figure 7: Detail view of the hinge of the operating unit

1 Cut-out section on the rear panel for the hinge of the operating unit
2 Hinge of the operating unit
3 Screw for securing the hinge

Mounting steps
1. From the rear side, hang the operating unit by inserting the hinges (2) into the

openings in the rear panel of the housing (1).

2. Hold the operating unit in place and secure the hinges (2) with the screws (3).

3. Insert the connection cable to the periphery board into the respective plug-in
positions (1 and 5) as shown in the figure.

4. Stick the supplied cable support to the inner right side of the station at the
same height as the cable and fix the flat cable.

5. Route the cables (3) of the operating unit options to the FC721 as indicated
and fix these cables with cable ties (4).

6. Insert the supplied inscription strips underneath the operating unit foil as shown
in the illustration.

7. Swivel the operating unit towards the FC721 and secure it using the four
screws.

1

2 3
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Figure 8: Inserting the inscription strips into the operating unit

1 Inscription LEDs 3 Inscription standard keys 2
2 Inscription standard keys 1 4 Inscription station type

1
2

3

4
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5.3 LED module
The LED module installed in the FC721-YZ contains 24 groups, each with one
red/green and one yellow LED. Any events can be assigned to the LEDs. Each
LED may be configured as a static or flashing indicator. Normally the LED indicator
is used as a zone indicator.

FC721-YZ with LED module

LED indicator (internal)

1 LED, red/green
2 LED yellow
3 Inscribable fields

The LED module is only built into the FC721-YZ and is not individually available as
an option.

C
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5.4 EVAC-NL operating unit FTO2007-N1 [NL] (FC721-
HZ only)
The EVAC-NL operating unit [NL] is an evacuation control unit for the functions
required in the Netherlands. It enables the operation of a maximum number of 10
evacuation zones.
The EVAC-NL operating unit is connected to the station-internal bus.

FC 721-HZ with EVAC-NL operating unit
FTO2007-N1 [NL]

EVAC-NL operating unit
FTO2007-N1

Operating and display panel for EVAC-NL
operating unit FTO2007-N1 [NL]

The EVAC-NL operating unit is not individually available as an option.

C
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5.5 Options

5.5.1 Fitting extra relay

Figure 9: Mounting of two relays

1 Fixing screws for the DIN rail 3 Relays 1 + 2
2 DIN rail 4 End clamp for the relays

Mounting steps
1. Insert the relays (3) on the DIN rail (2) and press them down until they latch.

2. Mount the end clamp (4) to secure the relays.

3. Depending on their intended use, connect the relays to the configurable control
outputs of the periphery board. For the pin assignment, refer to the product
characteristics of the respective periphery board.

3

2

1

4
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5.5.2 Installing an RS232/RS485 module

This component is installed in exactly the same way as for the operating units
with the PMI & mainboard FCM2004 and the PMI & mainboard FCM2027.

No more than one single interface module (RS232 or RS485) can be installed in an
FC721.
The serial modules include:
● RS232 module (isolated), FCA2001
● RS485 module (isolated), FCA2002
These modules are mounted in the slots designed for them on the operating unit.
The mounting procedure of the two serial modules is the same for all modules.

Space and location

Figure 10: Installation location of the serial modules

1 RS232 module in slot X14 or 2 RS485 module in slot X19

1 2
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Figure 11: Installation of the serial modules

1 RS232 module in slot X14 6 RS485 module in slot X19
2 2x fixing screw X14 Slot for RS232 module on the operating unit
3 Mounting links on support plate X19 Slot for RS485 module on the operating unit
4 Nut for screwed cable gland X3 Connection terminal on RS232 module
5 Screwed cable gland X2 Connection terminal on RS485 module

1

3
4

X2

X14

X3

X19
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Mounting steps
1. Mount the cable gland (5) with the nut (4) on the flange between the fastening

tabs (3).

2. Plug the serial module (1 or 6) into the corresponding connector (X14 or X19).

3. Secure the serial module to the fastening tabs (4) using the two screws (2).

4. Wire up the serial module with the intended components according to the pin
assignment.

Cable glands do not have to be fitted for wiring inside the housing only.

Pin assignments
The serial modules are connected as follows:
● RS232 module: X3 DTE-HOST
● RS485 module: X2 connector

5.5.2.1 X3 DTE HOST on RS282 module
Pin Designation Description

8 ←  DCD Data Carrier Detected

7 ←  DSR Data Set Ready

6 ←  CTS Clear To Send

5 0 V Ground

4 ←  RXD Received Data

3 DTR  → Data Terminal Ready

2 TXD  → Transmitted Data

1 RTS  → Ready To Send

Admissible cable cross-section: 0.2…1.5 mm²

T Participant with RS232 interface

X3

6

5

7

8

RTS

TXD

DTR

RXD

0 V

CTS

DSR

DCD

DTE-HOST

T

1

2

3

4
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5.5.2.2 X2 on RS485 module
Pin Designation Description

4 RS485_A Line A

3 RS485_B Line B

2 Not connected

1 Not connected

Admissible cable cross-section: 0.2…1.5 mm²

T1 First participant
Tn Last participant

*) Stub lines must not exceed 20 m!
● Consider the polarity A, B!
● Terminate the line after the last participant (Tn) with 120 Ω!

3

4

X2

RS485_B

RS485_A

T1

Tn

2

1 *)

A

B
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5.5.3 Install shield connection terminal blocks

Figure 12: Mounting of the shield connection terminal blocks

1 Shield connection terminal block 3 Philips screws M 3/6
2 Camp bar

Mounting steps
1. Secure the clamp bar (2) above the rectangular cable breakout opening on the

right with two screws (3)

2. Hang the shield connection terminal blocks (1) onto the clamp bar (2) and
fasten by tightening the knurled screws.

1 2
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5.5.4 Cable kit (communication)
The cable kit (communication) FCA2014-A1 is used as an intermediate piece for
wiring the external lines to the modules on the operating unit. The connecting
cables supplied are fully assembled and have a length of 1110 mm. The cable kit is
mounted in the top right of the housing instead of the shield connection terminal
blocks.

Figure 13: Installation of the cable kit (communication) on the rear panel (example, Standard housing)

1 Screw bushings in rear panel for terminal strip
2 Terminal strip with 2 shield connection terminal blocks and connection

terminals
3 2x fixing screws
4 Periphery board

Mounting steps
1. First remove the shield connection terminal blocks if present.

2. Screw the mounting rail (2) to the screw bushings in the rear panel (1) using
the two fixing screws (3).

3. Now wire the existing module to the operating unit using the cables provided
according to the allocation plan of the respective module.

4. Guide the cable to the operating unit along the rear panel and fasten using
cable ties.

1

2

3

4
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5.5.5 Insert license key
The license key (S1) FCA2033-A1 is inserted in the corresponding holder on the
rear of the operating unit.

Figure 14: Using the license key on the operating unit with PMI & mainboard FCM2027

Figure 15: Using the license key on the operating unit with PMI & mainboard FCM2004

1 Holder for the license key 2 License keys

Inserting
κ Raise clamp of retainer (1) slightly and push the license key (2) underneath the

clamp with the inscription pointing downward (broader, flat side to the top).

1
2

1
2
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5.5.6 19" mounting kit
The 19" mounting kit FHA2016-A1 serves as a retainer for installing a station into a
19" rack or into a 19" cabinet. To fix a station, the two retainers enclosed with the
kit must be mounted.
The mounting instructions described below apply to all housing types.

Figure 16: Installing the 19" mounting kit, taking the example of the Standard housing

1 Fixing screws for the station (3x or 5x), M5 x 10 pan head screws
2 Rear panel of the station
3 Fixing of the crossbars on the 19" housing or rack (2 screws each) with M5 x

10 pan head screws
4 19" housing or rack
5 19" cross bars (4x per kit)
6 19" housing brackets (2x per kit)
7 Hexagonal fixing screws M6 x 12 for housing brackets (2x per side) and

washers M6
8 Top 19" retainer
9 Bottom 19" retainer

1. Screw the 19" crossbars to the housing bracket. Consider the installation depth
of the station.

2. Secure 19" retainers to 19" rack or in 19" cabinet. Consider the mounting
height of the station.

3. Fix the station on the housing brackets.

1

2
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3

6
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8
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6 Installation
The following installation instructions refer to the specifications of the EN 54
standard and the manufacturer's recommendations. The installation may only be
undertaken by an electrician. Detailed instructions can be found in the system
documentation.
● Use a suitable cable, e.g., NYM 3 x 1.5 mm2 (max. 2.5 mm²) or a cable type

with similar performance features to connect the AC voltage from the line
supply.

● The line voltage fuse must be designed for a current level of 10 A.
● The mains connection cable must be routed into the control panel housing from

above or from the rear.
● Provide a suitable mains separator or an appropriately labeled automatic cutout

for the mains voltage connection.
● The nominal voltage required (AC 230 V or AC 115 V) is stated on the control

panel type plate.
● Use a separate residual current unit for residual current circuit breakers.

Depending on the installation conditions, voltage surge protection (primary
protection) is required for the mains connection.

Planning and system limits
Before the installation, check whether the system's planning is suitable for the
system limits. This applies e.g. to all technical data and details of cable lengths,
number of line devices, number of networked stations, battery capacity and
compliance with requirements from standards and national guidelines and local
requirements.
Details of planning can be found in the system documentation.

Information about lightning protection
Further information and detailed specifications relating to producing a lightning
protection concept can be found in the relevant literature and associated
standards.

WARNING

High voltage! Danger to life!
Risk of electric shock
● Mounting and installation work may only be undertaken by qualified staff and

when the system is de-energized.
● Only use cable openings or the edge protection strips provided to protect

cables.

NOTICE
Overvoltage
Damage possible
● Observe the nominal voltage required (AC 230 V) as per the control panel

type plate!
● The fuses used and stated in the factory must not be bypassed or replaced

with any type other than that stated.
● Take appropriate EMC protective measures when handling electronics

modules.
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6.1 Protection elements
Electro-magnetic influence and over-voltages may lead to faults in the fire
detection installation. Protection elements minimize these faults.
All stations are equipped with fine protection and EMC filters in the factory. This
applies to the components listed below:
● All inputs and outputs
● All lines leading away from the stations
If need be, protection elements for primary and intermediate protection must be
added by the costumer. These elements must be mounted at the zone limits (EMC
zone), not inside the stations.
Other possible measures by the customer
In installations that are especially endangered by lightning, surge protectors must
be installed. In case of excessive HF mains overlapping, mains filters must be
installed in the feed line.
Installation
Twisted cables are recommended for external supply lines and lines leading to
alarm devices.

6.2 Supply concept
The following table shows which types of energy supply are possible with the
FC721.

Use FC721

AC 230 V + batteries Standard

AC 230 V Possible

2x DC 24 V No

1x DC 24 V No

The following chapters describe the individual energy supplies in more detail.
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6.2.1 Operation with battery backup
The ↑ stations are normally operated with a power supply unit and batteries. The
power supply unit feeds the hardware with galvanically isolated system voltage,
simultaneously charging the batteries.
Together with the batteries, the power supply unit assumes the function of an
uninterruptible power supply unit. The batteries are permanently fed via a
monitored output. In case of a mains voltage failure, the batteries take over the
power supply of the control panel without interruption.
The hardware is optimally protected and operational interruptions can be largely
avoided.
This operation mode protects the hardware against the following:
● Voltage loss and undervoltage
● Mains overvoltage (in accordance with EN 54)
● High-energy interfering impulses (in accordance with EN 54)

Figure 17: Block diagram, power supply with battery backup

1 Electrical isolation
2 Umains / USys converter
3 Uninterrupted changeover switch
4 Batteries
5 Monitoring functions:

#MAINS: Mains voltage monitoring
#BATT: Battery monitoring
#CONV: Monitoring the output voltage

6.2.2 Operation without battery backup
The stations can be operated without batteries. This operation mode is used when
the stations are operated via a network with external buffering, or when battery
backup is omitted.

The battery monitoring function can be deactivated by means of the hardware or
Cerberus-Engineering-Tool.

Power supply

Station

~/=Umains USys

#MAINS #CONV

#BATT Ubattery

1

2

3

4
5



Installation
Position of printed circuit boards / components 6

45 | 118
Building Technologies A6V10211100_f_en_--

Fire Safety 2015-12-15

6.3 Position of printed circuit boards / components
Position of components in the FC721

1 Batteries
2 Power supply 70 W
3 Mains connection terminals

(L1,N,PE)
6 Periphery board (1-loop)
7 Type plate (enclosed, must be

attached to the outside of the
control panel housing at a clearly
visible point)

Options (extract)
4 2 extra relays
5 Shield connection terminal blocks or

cable kit (communication)
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6.4 Power supply - mains voltage connection
When supplied from the factory, the power supply's internal cabling is already
connected.

Power supplies available
● Standard: DC 24 V / 2.5 A, power 70 W, max. battery capacity which can be

connected 17 Ah (in the FC721, no more than 7 Ah due to a lack of space)
● Option: DC 24 V / 5 A, power 150 W, max. battery capacity which can be

connected 45 Ah (only in additional empty housing)

Figure 18: Mains connection

1 EMC-critical zone (no high-voltage power
permitted)

4 Cable strain relief for mains supply line

2 Mains connection from below (not permitted when
batteries are fitted)

5 Mains connection from above (recommended)

3 Disconnect terminal blocks 6 EMC boundary

● The network cables must be inserted from above.
● The mains lead must be placed along the left side of the housing (observe

EMC zone boundary).
● Signal and control lines must only be fed into the housing on the right from

above or from the rear.
● Batteries must be installed in the correct positions.
● No cable openings should be made in the base of the housing, unless an

additional empty housing is mounted below the FC721 to accommodate the
batteries.

● The line voltage required (AC 230 V / AC 115 V) is stated on the type plate of
the FC721.

X8 X7 X6 X11

X3X400

X1
X3

X8

5 6

2

4

3

1
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Connecting mains voltage

WARNING

High voltage! Danger to life!
Risk of electric shock
● Before connecting the mains voltage ensure that it is not energized and is

locked to prevent it being activated.

1. Lay the mains cable (5) along the left side of the housing.

2. Insulate the power cable as appropriate and connect it to the disconnect
terminal blocks (3). Use cable end sleeves for wires.

3. Fix the cable in place with the strain relief clamp (4).

4. Secure the cable with cable ties.

Detailed diagram

Figure 19: FC721 mains connection (Eco housing)

1 Power cable (supplied from above),
3 x 1.5 mm2, e.g., NYM cable type

5 Primary cabling for power supply

2 Strain relief clamp PE Protective conductor (terminal at the bottom)
3 Ground on the rear panel N Neutral conductor (terminal in the middle)
4 Disconnect terminal L1 External conductor (terminal at the top, with mains

disconnector)

1

5

2

L1

PE

N
4

3
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Additional empty housing
If a power supply (150 W) is needed, this must be accommodated in an additional
empty housing (Standard) together with the batteries.

Figure 20: Housing (Standard) for additional batteries
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6.4.1 Emergency power supply
Should the AC mains voltage fail, the emergency power supply will be provided by
the connected batteries with no interruptions. The emergency power bridging time
depends on the control panel's quiescent and alarm current and the battery
capacity used. Once the emergency power bridging time has lapsed, it must be
possible for the external signal transmitters to be activated in the event of an alarm.
This activation must also be ensured at a battery final voltage of DC 21.2 V.

NOTICE
Error during configuration detection
Additional effort for troubleshooting
● Only connect the battery connection cables (*) once all installation work is

complete because the station will start as soon as the batteries are
connected.

Figure 21: Diagram with battery wiring on 70 W power unit

Emergency power bridging time
Depending on national and local requirements, a bridging time of 72 hours or more
may be needed for the emergency power supply. The battery capacity needed
must be calculated and the calculation checked by measuring the power consumed
during an alarm (with mains voltage deactivated). The Quantities Tool software is
available for calculating the battery capacity.

New batteries / initial commissioning
When using new batteries, they must be charged for at least 24 hours before
commissioning. If the date of manufacture (printed on batteries) is more than nine
months ago, they will need charging for at least 48 hours.

Total discharge
There is no guarantee that totally discharged batteries can be correctly charged
again. Replace batteries that have been totally discharged with new ones. You
may only use the approved battery types for the emergency power supply in fire
detection systems. Also note the details provided by the battery manufacturer.

Akku  -

Akku 1 Akku 1

N
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6.4.2 Batteries

Calculating the battery capacity
Determine the battery capacity with the following formula:

KBatt = (IR total * tR + IA total * tA) * kdis * kage

KBatt Battery capacity in [Ah]
IR total Sum of operating current of all consumers in quiescent condition [A]
IA total Sum of operating current of all consumers in alarm condition [A]
tR Desired emergency power supply duration in quiescent condition [h]
tA Desired emergency power supply duration in alarm condition [h]

(standard 0.5 h)
kdis Correction factor for discharge

● kdis = 1.1 with ≤12-hour emergency power supply duration. In the
event of a longer emergency power supply duration, the factor can
be omitted.

kage Correction factor for aging
● kage = 1.25 if the desired emergency power supply duration is ≤24

h (according to DIN VDE 0833, part 2). In all other cases, the
factor can be omitted.

Example

KBatt = ((IR total * tR ) * kdis * kage ) + ((IA total * tA ) * kdis * kage )

For 12 h emergency power supply duration:
= ((0.9 A * 12 h) * 1.1 * 1.25) + ((3.5 A * 0.5 h) * 1.1 * 1.25) = 17.2 Ah

For 24 h emergency power supply duration:
= ((0,9 A * 24 h) * 1.25) + ((3.5 A * 0.5 h) * 1.25) = 29.2 Ah

For 72 h emergency power supply duration:
= (0.9 A * 72 h) + (3.5 A * 0.5 h) = 66.5 Ah
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Determining the battery type
Determine the battery type on the basis of the calculated battery capacity (see
table).

Designation Type Capacitance Order number

Battery (12 V, 7 Ah, VDS) FA2003-A1 7 Ah A5Q00019353

Battery (12 V, 12 Ah, VDS) FA2004-A1 12 Ah A5Q00019354

Battery (12 V, 17 Ah, VDS) FA2005-A1 17 Ah A5Q00019677

Battery (12 V, 26 Ah, VDS) FA2006-A1 26 Ah A5Q00019356

Table 2: Permitted batteries

NOTICE
Hardware damage
● Due to CE conformity only UL94-V2 batteries may be used.

Notes
● To achieve the system voltage of 24 V, two batteries must always be

connected in series.
● Batteries are not included in the scope of supply of the stations and must be

ordered separately.
● The battery capacity determines the charging current. The charging current

must be taken into account when calculating the power supply.
● The dimensions of the batteries are needed to determine the housing type.

Restriction of the battery dimensions
● With greater battery capacities, the additional empty housing (Standard) should

be used with a 150 W power supply.
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6.4.3 Periphery board
Position of connection terminals on periphery board (1-loop) of FC721 fire control
panel.

Figure 22: View of periphery board (1-loop)

X1 Connection of power unit
X3 Ribbon cable plug connection to PMI & mainboard (operating unit on

pivot frame)
X6 Monitored outputs for acoustic signal transmitter, alarm and fault

messages
X7 Changeover contacts for RT Alarm and RT Fault (remote transmission)
X8 Configurable inputs/outputs (1-4), supply voltage Usys 1
X11 C-NET loop 1 or stub 1+2
X400 Ribbon cable plug connection, peripheral data bus
Fxxx SMD fuses 1 A/T

More details of the periphery board (1-loop) can be found in the FS720 system
documentation in the A6V10210368 product data.

X8 X7 X6 X11

X3X400

X1

F400F501F601F401
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6.4.3.1 Relay for fault and alarm (RT activation)
Allocation of connection terminals on periphery board (1-loop) of FC721. A cable
cross-section of 0.2 to 1.5 mm2 can be connected to the terminals.

X7 Designation Description

6 FAU_NC Break contact fault (normally closed) Potential-free
directional contact
Max. DC 24 V / 1 A

5 FAU_COM Center tap fault (common)

4 FAU_NO Make contact fault (normally open)

3 AL_NC Break contact alarm (normally closed) Potential-free
directional contact
Max. DC 24 V / 1 A

2 AL_COM Center tap alarm (common)

1 AL_NO Make contact alarm (normally open)

The relays can be used e.g. for unmonitored activation of external devices.

Fault relay (inverse operation)
The fault relay is activated when at least one station fault has been detected. This
relay is activated when the control panel is in idle mode (NC/C, inverse operation).
In the event of a fault message, the relay changes the switching condition (to NO,
C). Thanks to inverse operation, a fault message will still be sent in the event of the
station losing all power.

Connection to an external monitoring
input (example)

Connection of external control
voltage e.g. for an acoustic or optical
fault message (example)

Alarm relay
The alarm relay is activated when at least one station alarm message has been
detected.
Example of connection with external signal transmitter, e.g. an optical normal
operation/alarm message display.

Normal operation

Alarm

X7

NO

NO
+

+ Ub (DC)

NO

+ Ub (DC)
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6.4.3.2 Monitored outputs for alarm and fault (FT activation)
Connection terminals on the periphery board (1-loop) of FC721. A cable cross-
section of 0.2 to 1.5 mm2 can be connected to the terminals.

X6 Designation Description

6 FAU_OUT Output fault

5 VSYS_O Supply output for consumer fault

4 AL_OUT- Alarm output (-)

3 AL_OUT+ Alarm output (+)

2 SOUND1- Output for acoustic signal transmitter (-)

1 SOUND1+ Output for acoustic signal transmitter (+)

The outputs can be used e.g. for monitored activation of remote transmission
equipment 'RT' (e.g. phone dialing equipment).
The connection lines are switched with a monitoring resistor (termination resistor).
The resistance value stated corresponds to monitored normal operation. All
resistance values outside this range result in a fault message.

Enabling example for transmitting a
fault message
Terminating resistor
R = 1.6 kohms – 2.3 kohms

Enabling example for transmitting an
alarm message
Monitoring resistor (R + Ri)
Rges = 2.3 kohms – 5.5 kohms

X6

X6

+

X6

AL_OUT-
AL_OUT+

+
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6.4.3.3 Connection of monitored acoustic signal transmitters
Connection terminals on the periphery board (1-loop) of FC721. A cable cross-
section of 0.2 to 1.5 mm2 can be connected to the terminals.

X6 Designation Description

6 FAU_OUT Output fault

5 VSYS_O Supply output for consumer fault

4 AL_OUT- Alarm output (-)

3 AL_OUT+ Alarm output (+)

2 SOUND1- Output for acoustic signal transmitter (-) Potential-free
directional contact
Max. DC 24 V / 1 A1 SOUND1+ Output for acoustic signal transmitter (+)

Diagram showing principle
In normal operation, the connection is monitored for wire breaks and short-circuits
on the connection line. A monitoring current flows through the termination resistor
R (2.3 kOhm to 5.5 kOhm). All resistance values outside this range are recognized
as faults. The termination resistor should be connected directly to the connection
terminals of the monitored signal transmitter.

In the event of an alarm (with output activated), the polarity on the connection
terminal is reversed and the blocking diode is switched in the conducting direction.
The external signal transmitter is activated with the output voltage (+DC 24 V).

Fx ⇒ SMD fuse 1 A/T (on the periphery board)
R ⇒ terminating resistor (coverage area 2.3 kohms – 5.5 kohms)
V ⇒ blocking diode type 1N 4xxxx
M ⇒ flow of current in normal operation (monitoring)
A ⇒ flow of current during an alarm
Note total current of the station (e.g. max. 2.5 A for the 70 W power unit).

X6

+

M

+
+
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6.4.3.4 Configurable inputs/outputs
Connection terminals on periphery board of FC721 station. A cable cross-section
of 0.2 to 1.5 mm2 can be connected to the terminals.

X8 Designation Description

6 GND_01 (–) supply output 1
DC 20 V – DC 30 V/1 A5 VSYS_01 (+) supply output 1

4 I/O4 Configurable input/output 4
Individual current max.

300 mA
total current max. 1 A

3 I/O3 Configurable input/output 3

2 I/O2 Configurable input/output 2

1 I/O1 Configurable input/output 1

Each of these freely configurable inputs/outputs can either be configured as an
input or output. The function and external circuit needed depend on the mode of
operation selected.
Example: Principle circuit on I/O 1 (connection 1)

I/O 1 as 'input'
The input can be triggered with a potential-free,
external switching contact. In such cases, the
corresponding input is switched to GND.
Depending on the programming, a permanent or
sensing contact can be connected. The activated
input can be used to program one of the station's
control functions.

I/O 1 as 'output'
Configuration as 'output' allows for the activation of
external devices (e.g. relays) with 'Vsys' voltage
should certain events arise. In such cases, the
corresponding output is switched to GND.
The output's activation condition (e.g. alarm, fault,
isolation etc.) is defined in the customer data
programming.

X8

X8

I/O1

X8

I/O1
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6.5 C-NET detector line
Up to 126 devices, such as automatic fire detectors, manual call points,
transponders, and other C-NET components, can be connected to the C-NET
detector line.
The connection of the C-NET detector line is on the periphery board. Most line
devices, such as fire detectors, are supplied with the operating voltage required
directly by the C-NET. An external power supply is required for the FDCIO223
transponder.

Figure 23: C-NET with various line devices
Line separator
All C-NET devices have an integrated line separator.
In the event of a fault, e.g. a short-circuit or wire break in the C-NET wiring, the line
separator is opened and the C-NET segment is shut down as soon as the fault was
found. The C-NET devices remain functional and ready to detect. The fault is
displayed on the station.
Connection factor (AK, RK, MK)
The number of connectable C-NET devices and the max. line length depend on the
device connection factor. The maximum number of 126 C-NET devices and the
max. length of line of 3300 m may be reduced significantly depending on the type
and volume of devices.

C-NET

FDCIO222

FDS229 FDS221 44

FDCIO222

4

FDCIO221

11

FDCIO221

1

FDCIO223

24 V DC

FDCL221

FDMxxx

FDF221-9
FDF241-9

FDL241-9

FT2010

FT2011

Synoptics
PCB

FT2001

FDCIO223

24 V DC

SynoLine 300

FC721
C

CerberusTM
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6.5.1 Connectable C-NET devices
The table below contains a list of all devices which can be connected to the C-NET
detector line. It also highlights which devices feature an alarm indicator (AI) and to
which an external alarm indicator (Ext. AI) or a sounder base (DBS720) can be
connected.

Device type Type Description ↑ AI Ext. AI DBS 720

Heat detector HI720 Heat detector for demanding
applications

X X X

HI722 Heat detector for standard applications X X X

Flame detector FDF241-9 Flame detector with three sensors for
demanding applications with many
deceptive phenomena

X X –

Smoke detector FDL241-9 Linear smoke detector for demanding
applications with many deceptive
phenomena

X X –

OP720 Optical smoke detector for standard
applications with few deceptive
phenomena

X X X

Multi-sensor
detector

OH720 Simple optical-thermal point detector X X X

OOH740 Optical-thermal multi-sensor fire
detector for demanding application

X X X

OOHC740 Optical-thermal multi-sensor fire
detector with CO measurement

X X X

OOH740-A9-Ex 2 Optical-thermal multi-sensor fire
detector with ambient supervision with
collective DualProtocol and FDnet/C-
NET. For areas at risk of explosion

X X X

Aspirating smoke
detector

FDA221 Aspirating smoke detector up to a
monitoring area of 500 m2

X X X

FDA241 Aspirating smoke detector up to a
monitoring area of 800 m2

X X X
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Device type Type Description ↑ AI Ext. AI DBS 720

Manual call point FDM221 Direct activation for indoor applications X – –

FDM223
FDM223H

Indirect activation (large housing) X X –

FDM223-Ex Indirect activation (large housing) for
areas at risk of explosion

X X –

FDM224
FDM224H

Indirect activation (large housing) X X –

FDM225 Direct activation for indoor applications X – –

FDM226 Direct activation for outdoor applications X – –
FDM233 Indirect activation, suitable for migration

from existing SIGMASYS systems to
Cerberus systems

X – –

FDM234 Direct activation, suitable for migration
from existing SIGMASYS systems to
Cerberus systems

X – –

FDM243H Indirect activation, robust housing for
use outdoors and in humid rooms,
suitable for migration from existing
SIGMASYS systems to Cerberus
systems

X – –

Input module FDCI221 1 potential-free contact input X – –

FDCI222 4 potential-free contact inputs X – –

Zone module FDCI723 1-zone module for connecting to
collective or conventional fire detectors,
with external supply. With safety barrier
SB3 for areas at risk of explosion as
well

X – –

Input/output
module

FDCIO221 1 potential-free contact input and
1 control output for any control

X – –

FDCIO222 4 potential-free contact inputs and
4 control outputs for any controls

X – –

FDCIO223 2 inputs/outputs can be alternatively
used either for controlling sounders or
connecting collective detector lines.
Mixed operation, i.e. 1 input channel
and 1 output channel, is also possible.

X – –

FDCIO224 4 potential-free contact inputs and 4
control outputs for the connection of the
VdS extinguishing interface in
compliance with the VdS or realization
of fire controls in compliance with
EN 54.

X – –
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Device type Type Description ↑ AI Ext. AI DBS 720

Line separator FDCL221 Line separator for the correct
connection of several stub lines at one
point on a loop

X – –

FDCL221-M Multi line separator module for the
correct connection of several stub lines
on a loop via a line separator

X – –

Ex loop separators FDCL221-Ex Line separator for the correct
connection of a stub line at one point on
a loop in an area at risk of explosion

X – –

Alarm sounder FDS221 Acoustic alarm device with various
tones and sound levels

X X –

FDS229 Acoustic alarm sounder with
supplementary optical indication with
various tones and sound levels and
beacon

X X –

Sounder base DBS720 Detector base with integrated alarm
device

– – –

Interbase DBS721 Sounder interbase with integrated
acoustic alarm device

– – –

DBS728 Interbase with integrated alarm device,
acoustic and optical

– – –

DBS729 Interbase with integrated alarm device,
acoustic and optical

– – –

Detector base DB721 Detector base with loop contact X X –

Floor repeater
terminal

FT2010 For the system-wide indication and
operation of the most important
information and functions

X – –

Floor repeater
display

FT2011 For the system-wide indication of the
most important information

X – –

Mimic display
indication

FT2001 For the system-wide indication of events X – –

External alarm
indicator

DJ119x For optical indication in the event of
alarm

– – –

External alarm
indicator

FDCAI221 Addressable alarm indicator that can be
assigned to any cause using a control

– – –

Radio gateway FDCW221 For the wireless transmission of
detector signals to the C-NET

X X –

Radio smoke
detector

DOW1171 Smoke detector for the wireless
transmission to the radio gateway
FDCW221

X -- –

Manual call point
with radio base

SMF6120
SMF121

Manual call point for the wireless
transmission to the radio gateway
FDCW221

-- -- –

SWING radio
gateway

FDCW241 Gateway for the wireless transmission
of detector signals to the C-NET 1

X X –
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Device type Type Description ↑ AI Ext. AI DBS 720

Neural radio fire
detector (SWING)

FDOOT271 Optical-thermal fire detector with radio
transmission to the radio gateway
FDCW241 1

X X –

Radio manual call
point (SWING)

FDM273 Indirect activation via radio gateway
FDCW241

X – –

FDM275 SWING manual call point, activation via
radio gateway FDCW241

X – –

Aspirating smoke
detector

VLF VESDA LaserFocus (laser monitoring) – – –

Table 3: Devices which can be connected to the C-NET detector line

X Possible / available
– Not possible / not available
1 Availability is communicated with the delivery release
2 Check with your country representative that this detector is approved for

C-NET in your country.

Most devices are supplied via the detector line.
The input/output module FDCIO223 must have an external power supply.
All ↑ C-NET devices have an integrated line separator.

NOTICE
Influencing the earth fault monitoring
Faults
● For devices on the C-NET with a separate supply, the supply must be

electrically isolated. FDCIO223 is an exception to this rule.

The number of connectable devices depends on the specific AK, RK, MK
connection factor of the type and is calculated using the 'Quantities Tool' software.
Note the specifications of the individual C-NET devices in the 'List of Compatibility'
document, see 'Applicable documents' chapter.
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6.5.2 C-NET topology and connection

Permissible topology for the C-NET
The C-NET can be wired in the topology shown below. Regardless of the topology
(loop, stub or loop with sub-stub), the C-NET system limits, such as length, cable
resistor, number of users etc., must be observed.
Either one loop or two stubs can be connected to the C-NET detector line of the
FC721 (2-wire line to block of 4 terminals).

Loop
(max. 1 loop)

Stub
(max. two stubs)

Sub-stubs on loop
A sub-stub must only be connected between two line devices or line
separators as well as directly to the terminal connection.

Wiring NOT admissible
NOT admissible!
Sub-stub on sub-stub

NOT admissible!
Sub-stub on a stub

C

CerberusTM

C

CerberusTM

C

Cerberus
TM

C

CerberusTM

C

Cerberus
TM
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The connection terminals for the C-NET are on the periphery board.

Figure 24: Position of C-NET connection terminal on the periphery board
● Max. 126 C-NET devices are permitted on the C-NET connection (block of 4

terminals).
● The C-NET devices can be distributed on the loop (max. 126 devices) or on

two stubs (max. 32 devices per stub).

Loop connection example
● Max. 126 line devices

Figure 25: C-NET loop circuit
Alternatively, the connection of two stubs instead of one loop is possible

Stub connection example
● Max. 32 line devices per stub
● Total of max. 64 line devices per line connection (4 terminals)

Figure 26: C-NET stub circuit

X11

1
2
3
4

+
-+
-

C

CerberusT M

1
2
3
4

+
-+
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C
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Cable types
As a result of national standards and requirements, installation may require a
particular cable type. Note the respective requirements and planning documents.
The following cable types can always be used for cabling the detector line:
● Twisted, with and without shielding (recommended)
● Untwisted, with and without shielding

Cable shielding
When using shielded lines (e.g. fire detection cable J-Y(St)Y n x 2 x 0.8 mm),
ensure that the cable shielding is only connected on one side.
The fire control panel's function may be impaired by a missing or incorrect cable
shielding connection. The 'Shield connection terminal blocks' option is available for
the connection. Depending on the installation environment and requirements of
relevant standards, cable shielding may have to be connected and merged at one
central connection point.

6.5.3 Wiring principle behind C-NET devices
The screw terminals for directly connecting the C-NET cable are integrated in every
C-NET line device. The connection terminals with input (+/-) and output (+/-) are
the same for all users, with the exception of the detector base.

Wiring example of C-NET detector devices on loop

Connection terminal
Detector base and sounder
base
● 1b (corresponds to +,

input/output)
● 5 (corresponds to input)
● 6 (corresponds to output)
Manual call point
Input/output modules
Transponder
Alarm sounder with beacon
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Figure 27: Wiring example of C-NET detector devices on stub
(1) If shielded connection cables are used, the cable shielding must be connected
on one side.
* The number of connectable C-NET devices and the max. line length depend on
the device connection factor. The maximum number of 126 C-NET devices per
loop and the max. length of line of 3300 m may be reduced significantly depending
on the type and volume of line devices. (Calculation must be performed using
'Quantity Tool' software).

C

CerberusTM
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7 Structure and function

7.1 Indication and operating elements
Fire control

panel FC721
LED module

FTO2008
Floor repeater

terminal
FT2010

Floor repeater
display
FT2011

Cerberus
Remote

Indication

Alarm X X X X X

Pre-alarm X X X X X

Fault X X X X X

Isolation X X X X X

Test mode X X -- -- X

Technology X X -- -- X

Activation X X -- -- X

Information (Note) X X -- -- X

Activated remote transmission (RT) X X X -- X

Operation

Acknowledge X -- X -- X

Reset X -- X -- X

Scroll in event lists X -- X X X

Deactivate internal buzzer X -- X X X
Deactivate sounder X -- -- -- X

Table 4: Functions of the individual operation and indication devices

X Possible / available
– Not possible / not available
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The FC721 has an integrated operation and indicator field which can be used to
operate, maintain and (with limitations) configure the station.

Figure 28: Operation and indicator field front of Cerberus fire control panel

1 Display, illuminated with plain text display
2 Cursor keypad for navigation/selection of menu items
3 Menu button
4 Keypad (for direct selections by entering numbers and/or entering and

changing objects-specific display texts)
5 C button (Cancel) and OK button (confirmation of selection)
6 Menu-dependent function keys (softkeys)

a

b

d

e

1 2 3

j

l n o

4 5 6g

h i

u

7 8 9p
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0 #

C
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7.2 Extra indication and operating devices
The FT2010 floor repeater terminal and FT2011 floor repeater display allow for the
decentralized indication of the most important events in the fire detection system
and limited operation. Both devices can be connected to the C-NET directly as bus
users. They can be powered via the C-NET or by an external power unit. If
supplied externally, the source of voltage requires electrical isolation.

Floor repeater terminal FT2010
The following indications and operations are possible on the floor repeater
terminal:
Indication
● Alarm and fault messages of connected station(s)
● Activated remote transmission (RT)
Operation
● Acknowledge (start investigation time)
● Reset
● Scroll in event lists
● Deactivate buzzer
● Four freely programmable keys

Floor repeater display FT2011
The following indications and operations are possible on the floor repeater
display:
Indication
● Alarm and fault messages of connected station(s)
Operation
● Scroll in event lists
● Deactivate buzzer

Guideline
● External power supply is possible with DC 24 V or AC 24 V.
● Floor repeater terminals and floor repeater displays that are not fed by the

detector line (separate power supply) must be electrically isolated from the
system voltage.

NOTICE
Influencing the earth fault monitoring
Faults
● Electrical isolation of the supply unit must be available for devices on the C-

NET that are fed separately. If there is no electrical isolation, the earth fault
monitoring on the C-NET is affected which may result in faults.

● When an external supply unit is used, it must be taken into account that should
the external supply unit fail, the maximum current connection factor increases
significantly (line failure is possible).

● When power supply is ensured via the detector line, the high maximum current
connection factor must be taken into account.

● At total of up to 8 floor repeater terminals and floor repeater displays can be
connected to fire control panel FC721.
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7.2.1 Mimic display driver FT2001
The mimic display driver is a parallel LED indication for the system-wide signaling
of events and is connected to the C-NET detector line.
The LED are built in a ground plan panel.

7.3 Connecting external alarm indicators
Some C-NET devices have an output where normally an ↑ external alarm indicator
is connected. The output can, however, also be used for any other controls. The
output for the external alarm indicator is controlled by the fire control panel and is
freely configurable.
Depending on the configuration, the output is activated for the external alarm
indicator if the following is true:
● The connected detector is in ↑ danger level 2 or 3 (together with the internal

alarm indicator).
● The assigned ↑ zone has triggered an alarm or ↑ pre-alarm.
● The assigned control is active.
The following ↑ external alarm indicators are available:
● DJ119x/FDAI9x – external alarm indicators that must be connected to the

detector to be displayed.
● FDCAI221 – addressable alarm indicator that can be assigned to any cause

using a control.

Figure 29: Examples of an external alarm indicator

1 External ↑ AI configured in parallel to the ↑ zone
2 External AI configured in parallel to the internal AI of the connected detector

(e.g. false ceiling)
3 External AI configured in parallel to any other zone (via control)

2

3

1
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7.4 Software
The following software is available for planning, configuration and commissioning:

FXS7212 Cerberus
Engineering Tool

For programming the object- and customer-specific control panel functions.

FX7220 Cerberus Remote Indicates a graphic representation of a station's PMI, provided that the PC is
connected to the station.
Cerberus-Remote is software for the PC which can be used to display the Person
Machine Interface of a 'Station' on the PC, if the corresponding approval is
granted. Depending on the operation mode, Cerberus-Remote can either be used
for display purposes or for display and operation purposes.

Quantities Tool The outline quantities tool can be used to calculate C-NET utilization (AK, RK, MK
connection factors) and determine the C-NET line card load.
This results in e.g.:
● Number and type of devices per detector line
● Number of required line cards
● Number of C-NET loops and stubs
● Battery capacity required (emergency power supply)

Detailed information on configuration of the fire detection installation and working
with the software tools can be found in the reference documents stated.
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8 Operation functions
The following chapters contain descriptions of important functions for directly
operating the ↑ site.
You will find information on the system functions in the corresponding chapter.

8.1 Selection and opening / execution
After calling up the main menu and any other list, the first entry in the list is
selected. The selection is indicated by a rectangular frame around the entry.
The opening of a list item or the execution of a list command is performed by
moving the cursor to the selected entry and pressing <ok>.
Other methods to open or execute a highlighted list entry are given by pressing the
following buttons:
● <►>
● <Number> on the numerical block (given number in brackets – only in selection

lists)

Changing the selection
The selection indicated is changed as follows:

Button Consequence

<▼> Next entry

<▲> Previous entry

<More alarms> Opens alarm list / jumps to the next
entry in the alarm list shown

<Number> + <ok> Goes to the entry with the number
entered – not in selection lists

More Options' + 'Jump to begin' softkeys Jump to the top of the list

More Options' + 'Jump to end' softkeys Jump to the end of the list

8.2 Scrolling
You can use the navigation keys to scroll through a displayed list in the display.
You can scroll to the start/end of the lists (limited function) and back in the
following lists:
● Option lists
● Command lists
● Element category lists
In all other lists, you can scroll beyond the end of the list to the start of the list and
back.
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8.3 Indication of the position and length of the list
There is a vertical bar along the side of a list when the list is longer than can be
indicated on the display.
The black part of the bar shows the position and size of the part of the list you can
see in relation to the entire list.
Examples for the representation in different lists:

1 Bar in normal view with list 2 Bar in window with list

8.4 Shortcut
A shortcut serves for the direct execution of an entry in a selection list by pressing
a numeric key.
In a command list, for example, you can execute a command directly by entering
the corresponding number.
The numbers for the shortcut are shown in the list entry line, on the right and in
brackets.

8.5 Favorites
You can use favorites to execute several operation sequences or one operating
sequence in an operation sequence.
A maximum of 8 favorites are configured and you can select them from the favorite
list in the 'Favorites' main menu item.
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8.6 Entry of numbers and letters
You can use the keyboard to enter numbers and letters in input dialogs.

Numeric entry
● The number of underscores corresponds to the number of possible positions

for the entry.
● The overwrite mode is set by default; there is no insert mode.
● Horizontal navigation within the input field is possible with the keys <◄> and
<►>.

● Use <▲> to delete the character to the left of the cursor position.
● Use <ok> to save the entered value and exit the input field.

– When there are several input fields in the window, the cursor jumps to the
next field by pressing <ok>.

– If the cursor position is in the last or only input field, close the input dialog
by pressing <ok>.

● Use <C> to cancel the input and close the dialog without saving.

Alphanumeric entry
● Alphanumeric entries are only possible in particular input fields, e.g. for

customer text.
● Letters are entered in the same way as letters on telephones. You can select

the corresponding letter by pressing a key several times.
● Switching between lower and upper case letters is possible with the key <*>

and only applies for the next character.

In input fields with more than one line, you cannot change back to a line above
the cursor position.
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9 Connectivity and communication with 'Station'
A PC does not have to be directly connected to a ↑ 'Station' to be able to
communicate with a 'Station' in the ↑ 'Site'. The PC can be connected to any place
in the Ethernet.
Detailed information about the connection variants can be found in the
'Establishing connection from PC to FS720 network' chapter in document
A6V10210424. See chapter 'Applicable documents'.

9.1 Setting Windows firewall
● The Windows firewall may prevent the PC connecting to the ↑ 'Station'.
● A functioning Ethernet connection between the Cerberus-Engineering-Tool on

the PC and the FS720 control panels is required to update the firmware, for
example.

Setting Windows firewall
● Create a firewall rule for Windows. To do this, proceed as follows:

You must have administrator rights to make the following settings.

9.1.1 Windows XP
ϖ You have administrator rights on your PC

1. Open the Windows start menu.

2. Select 'Settings' > 'Control panel' > 'Administrative Tools' > 'Services'.

3. Right-click on 'Windows Firewall/Internet Connection Sharing (ICS)' in the new
window.

4. Select 'All Tasks' > 'Exit' in the context menu.

5. Once the work is complete, reactivate the firewall. To do this, proceed as
described above but select 'All Tasks' > 'Start' in the context menu.

NOTICE
Security vulnerability in operating system due to deactivated firewall
Unauthorized access to your PC
● Activate the firewall after the firmware update.
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9.1.2 Windows 7 / Windows 8 / Windows 10

There are different ways of setting up firewall rules in Windows 7/8/10. The
following settings apply for Siemens PCs which use group guidelines controlled
by the domain.

NOTICE
The following settings must be made under Local Security Policy.
● Open Local Security Policy to configure Windows Firewall with Advanced

Security.

ϖ You have administrator rights on your PC.
ϖ The PC is connected to the Siemens intranet.

1. Open the Control Panel.

– E.g., via the Windows Start menu in Windows 7.
– E.g., in Windows 10: Right-click on the Windows symbol at the bottom left

and select Control Panel in the context menu.

2. NOTICE! The following settings must be made under Local Security Policy.
Select 'Control Panel' > 'All Control Panel Items' > 'Administrative Tools' >
'Local Security Policy' > 'Windows Firewall with Advanced Security'.

3. Expand the subtree of the menu.

4. Right-click 'Inbound Rules' > 'New Rules'
 This opens the 'New Inbound Rule Wizard'.

5. Select 'Rule Type' and activate 'Program'.

6. Click 'Next >' to confirm and enter the program path to 'F-FXS7212.exe'.

– Example: C:\Program Files (x86)\Siemens\F-FX7230\XS_en_1-V5.0
– NOTICE! Remember to enter/add the new path if the version changes.

7. Click 'Next >' to confirm and then confirm the default setting 'Allow the
connection' in the next step ('Action').

8. In the next step 'Profile', remove the check mark from the 'Domain' checkbox.
 The 'Private' and 'Public' checkboxes are checked.

9. Click 'Next >' to confirm and enter an appropriate name in the next step
('Name'), such as 'FS720 application'.

10. Click 'Finish' to complete the process.
 A 'New Rule' has now been set and appears in the 'Inbound Rules' list.
It is necessary to make additional settings for the new rule:

1. Right-click the new rule and select 'Properties'.

2. Select the 'General' tab in the 'Rule Name Properties' window.

3. Set the following values:

– 'General': 'Activated'
– 'Action': 'Allow connection'

4. Select the 'Protocol and Ports' tab.



Connectivity and communication with 'Station'
Connecting the PC to the station9

76 | 118
Building Technologies A6V10211100_f_en_--

Fire Safety 2015-12-15

5. Set the following values:

– 'Protocol type': 'UDP'
– 'Local port': 'Specific Ports', and enter the value range '50067-50070' in the

box.
– 'Remote port': 'All Ports'

6. Confirm with 'OK'.
 The new firewall rule is now configured.

NOTICE
Security vulnerability in operating system due to open ports
Unauthorized access to your PC
● Deactivate the firewall rule configured above after the firmware update.

9.2 Connecting the PC to the station
For most commissioning, maintenance and repair work a PC with installed
Cerberus-Engineering-Tool is required. The figure below shows the connection
between the PC and ↑ 'Station'.

Figure 30: Rear panel of operating unit and PC

LAN Ethernet connection
1 Cable, type CAT 5 or CAT 7, crossover, max. 100 m

LAN 11



Connectivity and communication with 'Station'
Disconnecting the PC from the station 9

77 | 118
Building Technologies A6V10211100_f_en_--

Fire Safety 2015-12-15

9.3 Disconnecting the PC from the station
As the IP address is bound to the MAC address while there is a connection
between the PC and the ↑ 'Station' and as it remains in the cache even in the case
of a short break in the connection of ≤2 min., you must observe the following
instructions.

NOTICE
Incorrect disconnection of 'Station'
Establishing a connection to other 'Station' is not possible
● Disconnect the PC from the 'Station' as described in the following instructions.

The connection between the PC and the 'Station' must be disconnected as follows:

1. Select 'Cerberus-Engineering-Tool' > 'Commissioning' in Disconnect.

2. Disconnect the cable connection between PC and 'Station'.

3. Wait ≥2 min. before you establish a connection to another 'Station'.

9.4 Loading data to the 'Station'
Data is loaded from Cerberus-Engineering-Tool to the 'Station' when the following
commands are performed.
● 'Initialize station'
● 'Download site'

If you use a number of network cards on the PC, observe the information in the
chapter 'IP settings for several network cards' in document A6V10210424. See
chapter 'Applicable documents'.

The table below shows which data is overwritten in the 'Station'.

Command Overwrites the
↑ BDV

Sets the address
of the 'Station'

Overwrites the
configuration

'Initialize station' 1 Yes Yes Yes

'Download site' Yes No Yes 2

1 Command is only performed for the 'Station' that is connected to the PC via LAN.
2 The configuration of selected 'Stations' or all 'Stations' in the ↑ 'Site' can be
overwritten as an option.

See also
1 Loading configuration from the PC to the station [➙ 80]
1 Initializing 'Station' [➙ 78]
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9.5 Initializing 'Station'
● Each ↑ 'Station' in a system with several networked 'Stations' must have a

unique address.
● Once a 'Station' has been started for the first time or once the firmware on the

main CPU has been updated, a 'Station' has the address '1'. Networked
'Stations' must therefore all be initialized.

● If two 'Sites' are merged to form one ↑ 'Site', the 'Stations' with the same
addresses in the added 'Site' must each be given a new address.

● The 'Initialize station' procedure issues the 'Station' an address within the 'Site'
according to the configuration in Cerberus-Engineering-Tool.

A ↑ standalone 'Station' does not have to be initialized.

If you use a number of network cards on the PC, observe the information in the
chapter 'IP settings for several network cards' in document A6V10210424. See
chapter 'Applicable documents'.
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Initialize 'Station'

NOTICE
Connection module (card cage) FCA2006-A1 defective or installed incorrectly
Control panels identified incorrectly, e.g. FC726 identified as FC724.
● Check that the connection module (card cage) FCA2006-A1 is installed

correctly.

NOTICE
Faulty initialization for networked station
During initialization, the station must not be connected to the network or any other
station.

ϖ The PC is connected locally to the ↑ 'Station'.

1. Highlight the 'Station' you want to initialize.

2. Select the 'Commissioning' > 'Initialize station' menu item.
 The following window is opened:

3. Click on 'Start'.
 The 'Set the station to access level 3' window opens.

4. Press <MENU> on the 'Station' and enter a valid PIN.

5. Click on 'OK' in the 'Set access level' window.
 The 'Station' is initialized.
 The 'Station' is restarted.
 After a few minutes, the 'Buzzer' sounds twice.

6. Press <Acknowledge> on the ↑ Person Machine Interface to switch off the
'Buzzer'. Do not perform any more actions on the 'Station' until the 'Buzzer' has
sounded for the second time.
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9.6 Loading configuration from the PC to the station
You can use the 'Download site' function to load the configuration of one ↑ 'Site'
from the Cerberus-Engineering-Tool on the PC into the 'Station'.

NOTICE
Different network configuration in Cerberus-Engineering-Tool and networked
↑ 'Site'
When the selection displayed for 'Download site' is manually modified, in special
cases1 it may be necessary to reset a 'Station' to the factory setting as well as a
'Initialize station'.
● Do not modify the selection displayed for 'Download site' in normal cases.
● Check the sequence when loading different configuration states in special

cases 1.
● After any change of the network configuration, make sure that all 'Stations' in

the 'Site' for the 'Download site' procedure are selected and can be accessed.
● Temporarily update non-accessible 'Stations' to the latest status of the global

network configuration prior to integration in the network.

1 Examples of special cases:
● A 'Station' will be added to a networked ↑ 'Site' and a new network

configuration will be loaded upon initialization of this 'Station', different from the
global network configuration of the connected 'Site'.

● During the 'Download site' procedure a 'Station' is temporarily not accessible.
Both examples can result in the 'Station' no longer starting after the 'Download site'
procedure and the above actions having to be carried out.

If you use a number of network cards on the PC, observe the information in the
chapter 'IP settings for several network cards' in document A6V10210424. See
chapter 'Applicable documents'.

WARNING

Activation of fire or smoke dampers
If fire or smoke dampers are connected to the FS720 via an input/output module,
they may be activated when the station is switched off or when the station or
detector line is restarted.
● If necessary, block the outputs temporarily [➙ 101] before switching off the

station or restarting the station/detector line.
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ϖ The ↑ 'Site' is opened in Cerberus-Engineering-Tool.
ϖ The PC is connected to the 'Station'.
ϖ Networked 'Stations' are initialized.
ϖ 'Station' and Cerberus-Engineering-Tool have the same 'Site' ID.
ϖ 'Station' and Cerberus-Engineering-Tool are part of the same sales channel.

1. Select 'Commissioning' > 'Download site' in Cerberus-Engineering-Tool.

 The 'Download site' and 'Connect' windows open in Cerberus-Engineering-
Tool.

2. Select the connection in the 'Connect' window and click on 'OK'.
 The 'Stations' are listed in the 'Download site' window.

3. Select the 'Stations' whose configuration you would like to load from Cerberus-
Engineering-Tool to the 'Stations' and click on 'Start'.
 The 'Set access level' window may open in Cerberus-Engineering-Tool with

the 'Set the station to access level 3' prompt. Press <MENU> on the
'Station', enter the PIN and press <ok>.

4. Click on 'OK' in the 'Set access level' window in Cerberus-Engineering-Tool.
 The 'Action confirmation' window opens in Cerberus-Engineering-Tool.

5. Click on 'Yes'.
 The configuration is loaded to the 'Station'.
 The progress is displayed in the 'Download site' window in Cerberus-

Engineering-Tool.
 The 'Station' restarts.
 After a few minutes, the 'Buzzer' sounds twice at the 'Station'.

6. Press <Acknowledge> on the ↑ Person Machine Interface at the 'Station' to
switch off the 'Buzzer'. Do not perform any more actions on the 'Station' until
the 'Buzzer' has sounded for the second time.
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9.7 Loading configuration from the station to the PC
The 'Upload site' function can be used to load the configuration of a ↑ 'Site' to
Cerberus-Engineering-Tool on the PC.
ϖ The 'Site' is opened in Cerberus-Engineering-Tool.
ϖ The PC is connected to the 'Station'.
ϖ 'Station' and Cerberus-Engineering-Tool have the same 'Site' ID.
ϖ 'Station' and Cerberus-Engineering-Tool are part of the same sales channel.

1. Select 'Commissioning' > 'Upload site'.

 The 'Upload site' and 'Connect' windows are opened.

2. Select the connection in the 'Connect' window and click on 'OK'.
 The 'Stations' are listed in the 'Upload site' window.

3. Select the 'Stations' whose configuration you would like to load to Cerberus-
Engineering-Tool and click on 'Start'.
 The 'Action confirmation' window opens.

4. Click on 'Yes'.
 The configuration is loaded to the PC.
 The progress is displayed in the 'Upload site' window.

9.8 Creating a backup of the 'Site' configuration
With the 'Create backup embedded configuration' function, you can create a
backup file of the ↑ 'Site' configuration.
The following conditions must be satisfied for a complete backup:
● All of the ↑ 'Stations' in the 'Site' must be networked and commissioned.
● The 'Site' IDs for all 'Stations' must match the 'Site' ID for the 'Site' loaded in

Cerberus-Engineering-Tool.
● The ↑ BDVs for all 'Stations' must be compatible with the BDV for the 'Site'

loaded in Cerberus-Engineering-Tool.
– The BDVs are compatible when the major version and the minor version

are identical. The bugfix version is not relevant for the compatibility. The
versions are saved in the BDV file name. You will find more information on
the format of the BDV file name in document A6V10210424.

● The country codes of the BDVs for all 'Stations' must match the BDV for the
'Site' loaded in Cerberus-Engineering-Tool.

You will find information about ↑ BDV names and versions in document
A6V10210424. See chapter 'Applicable documents'.

If the above-mentioned conditions are not satisfied, a corresponding message is
displayed and an incomplete backup file created. In this instance, 'incomplete' is
added to the file name of the backup file.
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Creating a backup
ϖ The ↑ 'Site' is opened in Cerberus-Engineering-Tool.
ϖ The PC is connected to a ↑ 'Station'.

1. Select 'Commissioning' > 'Create backup embedded configuration'.
 The 'Create backup embedded configuration' And 'Connect' windows are

opened.

2. Select the connection in the 'Connect' window and click on 'OK'.
 The 'Site' configuration is loaded to the PC and saved as a backup file.
 The progress is displayed in the 'Create backup embedded configuration'

window.

Backup file
● The backup file is saved in the following directory as standard:

C:\ProgramData\Siemens\FX7230\[Softwareversion]\Sites\embeddedBackups
● The backup file has the following name:

<'Site' name>_<backup counter>(_incomplete).fsc
Example: Test_Site_007_incomplete.fsc
– 'Site' name: Name of the 'Site'.
– Backup counter: Three-digit number that is automatically assigned to each

backup.
– 'incomplete': If it was not possible to create a complete backup, 'incomplete'

is added to the file name.
● A maximum of ten 'Site' backup files are saved. If more than ten backup files

are created, the oldest file is automatically overwritten with the new one.

In the pre-settings, you can define that a backup file is created automatically each
time a configuration is loaded from the PC to the ↑ 'Station' using the 'Download
site' command. To do this, select 'Options' > 'Preferences' > 'Commissioning'.
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10 Commissioning
This chapter describes initial commissioning of the Cerberus PRO fire control panel
(individual control panel, not networked).
● Activating access level
● Start auto-configuration
● Display C-NET line devices
● Enter customer texts for the control panel, C-NET and individual line devices

via the control panel keypad

Figure 31: Line tester FDUL221

NOTICE
Connecting C-NET and line tester to the station at the same time
The line tester or station may be damaged.
● Do not connect C-NET and line tester to the station at the same time.

ϖ C-NET is not yet connected to the station.
ϖ Before commissioning and auto-configuration of the stations, the connected C-

NET loops or stubs must be checked for correct function using the FDUL221
line tester.

1. Connect the line tester FDUL221 to the C-NET detector line.

2. Test the C-NET detector line for short-circuits, open lines, and ground faults.

3. Check the number of devices on the C-NET detector line based on the display
on the line tester.

4. Check the branch-off position of the stubs and the number of devices at the
stubs.

5. Check the type of the respective C-NET device.

6. Remedy any errors/faults which may be active before commissioning or auto-
configuration

You will find information about line tester FDUL221 in document 008250.
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10.1 Activating access level
The 'Station' is protected against unauthorized operation by access levels.
Authorization for access level 3 is needed for the functions described below.

If the authorization code is not entered, operation is only possible in access level
1 (guest), e.g., for acknowledging the control panel buzzer or scrolling through the
display messages.

The authorization code set in the factory is '0000'. This authorization code must be
changed once the station has been configured.

Logout timeout
The 'Station' is provided with a time control function for the operation.
The operation enable for an access level expires after a configurable period of time
has passed since the last entry.

10.1.1 Log in / Change access level
You can enable an 'Access level' by entering your PIN in the PIN entry dialog, or by
pressing <ok>. Alternatively you can use the key switch (optional) to release an
Access level.
If you press a key on the ↑ Person Machine Interface whose function requires a
higher 'Access level', the PIN input dialog is displayed automatically.

Login/logout

Enter PIN:      ****
Logout or guest-login: no PIN + <ok>

Confirm with <ok>/Exit with <C>
Delete with <Cursor up>

Table 5: PIN entry dialog box

Enabling an 'Access level' without a PIN
1. Press <Menu> on the keypad.
 The PIN input dialog is indicated.

2. Do not enter a PIN and confirm with <ok>.
 The lowest 'Access level' is enabled.
 The main menu is open.

Enabling an 'Access level' with a PIN
1. Press <Menu> on the keypad or select the 'Main menu' > 'Login/logout'' main

menu item.
 The PIN input dialog is indicated.

2. Enter your PIN and confirm with <ok>.
 The corresponding 'Access level' is enabled.
 The main menu is open.

The present 'Access level' is indicated in the main menu in the header of the
display.
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10.2 Auto-configuration of control panels
This function requires the control panel, components, and C-NET to have been
correctly installed. Once auto-configuration is complete, the control panel is ready
for detection with limitations. A fire is recognized by the connected fire detectors
and displayed on the control panel. Configuration with the FXS7212 Cerberus
Engineering Tool is required in order to assign controls, define individual alarm
responses, and make adjustments in line with object-specific requirements.

NOTICE
Overwriting an existing configuration
Parts of an existing customer-specific configuration are lost.
● First save an existing customer-specific configuration.

ϖ Every loop or stub line is tested with the line tester FDUL221 to ensure it is
functioning and installed correctly.

κ Run auto-configuration as described in the 'Auto-configuring a line' chapter.
 The station is ready to detect - with limitations. The C-NET devices have been

addressed. Should an event occur, e.g. a triggered fire detector and its C-NET
address are displayed.

WARNING

Control panel is ready for detection - with limitations.
Alarm transmission to the fire brigade is not configured.
Activation of acoustic signal transmitters is not configured.
● Configure the controls needed.

Customer text (e.g. detector number, installation location etc.) can be entered for
each C-NET device for improved clarity.
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10.2.1 Auto-configure line
The 'Line' element category in the 'Maintenance' menu facilitates the reading-in of
the current topology, for example. This creates part of the elements in the
'Detection tree'.

NOTICE
Overwriting an existing configuration
Parts of an existing customer-specific configuration are lost.
● First save an existing customer-specific configuration.

Auto-configuring a line:
1. In the main menu, select the 'Topology' menu item.
 The 'Topology' window is open.

2. Select 'Hardware tree'.
 The 'Element' window is open.

3. Select 'Station' and press the 'Lower level' <softkey>.
 The elements of 'Station' are displayed.

4. Select the corresponding 'C-NET line card (onboard/FCL2001)' module and
press the 'Lower level <softkey>.
 All lines of 'C-NET line card (onboard/FCL2001)' are indicated.

5. Select a line and press 'More Options' <softkey>.
 The 'Select option' window is open.

6. Select 'Execute commands' and confirm with <ok>.
 The window including the possible commands is displayed.

7. Select the 'Auto-configure line' command and confirm with <ok>.
 The line is auto-configured.
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Display for auto-configuration

Main menu
Exit with <C>

Access level 3

Message summary
Functions
Favorites
Topology

(1)
(2)
(3)
(4)

Element search
Event memory
Login/logout
Settings/administration

(5)
(6)
(7)
(8)

Function
On/Off

Function
All

LED
test

κ Select 'Topology', continue with <ok>

Topology
Exit with <C>

Access level 3

Detection tree
Hardware tree
Control tree

(1)
(2)
(3)

Function
On/Off

Function
All

LED
test

κ Select 'Hardware tree', continue with <ok>

001 Element Hardware tree

Station 1

Lower
level

More
Options

κ Select 'Station 1', continue with 'Lower level' <softkey 2>

005
FC721

Elements
Main building

Station 1

Module
Module
Module
Module

1
2
3
4

Onboard I/Os
Onboard I/Os
'C-NET line card (onboard/FCL2001)'
Communication interfaces

Upper
level

Lower
level

More
Options

κ Select 'Module 2', continue with 'Lower level' <softkey 2>
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007   Elements
'C-NET line card (onboard/FCL2001)'

Module 2

Line
Line
Line
Line

11
12
21
22

Line
Line
Line
Line

Upper
level

Lower
level

More
Options

κ Select 'Line 1', continue with 'More Options' <softkey 3>

Selecting option

Execute commands
Show details

(3)
(5)

κ Select 'Execute commands', continue with <ok>

Select command

Read in installed devices
Detector line OFF
Auto-configure line
Set customer text
Accept replaced devices

(1)
(2)
(3)
(4)
(6)

κ Select 'Auto-configure line', continue with <ok>
 The line is auto-configured.

10.3 Displaying C-NET devices
After auto-configuration, the individual C-NET detector lines and the associated C-
NET devices of each line can be displayed and configured.

Depending on the control panel type (2 or 4 loops) and the control panel design,
the depiction may vary and several lines may be displayed.

You can display the lines and devices as follows. The displays are depicted in the
same way as those in the 'Auto-configuring a line' chapter with the exception of the
'Show details' command.
ϖ At least one line is configured.

1. In the main menu, select the 'Topology' menu item.
 The 'Topology' window is open.

2. Select 'Hardware tree'.
 The 'Element' window is open.

3. Select 'Station' and press the 'Lower level' <softkey>.
 The elements of 'Station' are displayed.
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4. Select the corresponding 'C-NET line card (onboard/FCL2001)' Module and
press the 'Lower level' <softkey>.
 All lines of 'C-NET line card (onboard/FCL2001)' are indicated.

5. Select a line and press 'More Options'' <softkey>.
 The 'Select option' window is open.

6. Select 'Execute commands' and confirm with <ok>.
 The window including the possible commands is displayed.

7. Select the 'Show details' command and confirm with <ok>.
 The details are displayed.

Example of selecting a line

004   Elements
C-NET line card
(onboard/FCL2001)

Module 2

Line
Line
Line
Line

11
12
21
22

Line
Line
Line
Line

Upper
level

Lower
level

More
Options

004   Elements Line 12

Device
Device
Device
Device

11
12
21
22

OH720
HI720
OP720
OP720

Upper
level

Lower
level

More
Options

κ Check whether all devices of this C-NET detector line are displayed correctly.
You can use the type designation to detect the type of device displayed (smoke
detector, heat detector, manual call point etc.)

You will find a list of type designations in the 'C-NET devices' chapter
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10.4 Entering/Changing customer text
You can enter customer text for any element on the control panel, independently of
Cerberus-Engineering-Tool.

Once customer text has been entered or changed, the updated display is only
shown the next time the element is accessed.
Entering or changing customer text does not lead to a reboot.

'Set customer text'
1. Select an element

2. Press the 'Execute Commands' softkey

3. Select the 'Set customer text' command.

4. Enter the desired customer text and confirm the entry with <ok>.
 The customer text has been entered.

Changing customer text
Proceed in the same way as when entering customer text but change the existing
customer text.

10.5 Setting the system time
The set system time is used to log all the control panel's messages, save them in
the event memory and output them on a connected printer.

10.5.1 Setting time and date
You will have to reset the clock if the fire control panel has been de-energized. In
countries with central European summer time (CEST), the system clock
automatically switches between daylight savings time and regular time.

'Enter date / time'
1. Select 'Main menu' > 'Settings/administration' > 'System commands'.
 The 'System commands' window is open.

2. Select 'Set system time'.
 The 'Enter date / time' window is open.

3. Enter the date and time and/or confirm with <ok>.
 The cursor jumps to the next field and terminates the input after the last

field.
 Adjusted or confirmed date and time are set.

Enter date / time

25-04-09   12:42:58
(dd-mm-yy)   (hh:mm:ss)

Confirm with <ok>/Exit with <C>
Delete with <Cursor up>

Table 6: Input window for time and date
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10.6 Changing access authorization PIN
After successful commissioning, the 4-digit access authorization (PIN) for the
corresponding access level must be changed. Keep the new PIN in a safe place.
If the PIN is lost, a system reset must be undertaken to the station's factory setting.
The control panel configuration, including all customer data, is cleared in the
process.
The '0000' PIN set in the factory then applies again after a system reset.

10.6.1 PIN administration
You can change an existing PIN and create a new PIN or delete a PIN with the
corresponding authorization.

PIN administration not available
If PIN administration is not available at the station, you must configure the PINs in
Engineering Tool. You will find more information in document A6V10210424.

'Change PIN'
1. Select 'Main menu' > 'Settings/administration' > 'Manage PINs'.

2. Select the 'Change PIN' menu item.

3. Enter the PINs in accordance with the input fields and confirm with <ok>.
 The PIN has been changed.

Change PIN

Old PIN:                 ****
New PIN:                ****
Verify new PIN:     ****

Confirm with <ok>/Exit with <C>
Delete with <Cursor up>
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'Create PIN'
ϖ You have the required authorization level.

1. Select 'Main menu' > 'Settings/administration' > 'Manage PINs'.

2. Select the 'Create PIN' menu item.

3. Enter an admissible access level.

4. Enter the PIN in accordance with the input fields and confirm with <ok>.
 A new PIN has been created.

Create PIN

Access level:    __
Enter PIN:    ****
Verify PIN:   ****

Confirm with <ok>/Exit with <C>
Delete with <Cursor up>

'Delete PIN'
ϖ PIN is present.
ϖ You have the required authorization level.

1. Select 'Main menu' > 'Settings/administration' > 'Manage PINs'.

2. Select 'Delete PIN'.

3. Enter the PIN in accordance with the input fields and confirm with <ok>.
 PIN has been deleted.

Delete PIN

Enter PIN:    ****
Verify PIN:   ****

Confirm with <ok>/Exit with <C>
Delete with <Cursor up>



Commissioning
Restart the station10

94 | 118
Building Technologies A6V10211100_f_en_--

Fire Safety 2015-12-15

10.7 Restart the station

The configuration of the ↑ 'Station' remains the same.

There are the following ways in which to restart the ↑ 'Station':
● Via the menu on the display
● PMI & mainboard FCM2004 and FCM2027: With the 'S32' button
● ↑ CPU card: With the 'S8' button

Via the menu on the display
If you are using two ↑ CPU cards, you must perform the following procedure once
for each CPU card.

1. Press <MENU>.
 The PIN input dialog is displayed.

2. Enter a valid PIN and confirm with <ok>.
 The 'User successfully logged in' message is displayed.
 The main menu is displayed.

3. Select the 'Topology' > 'Hardware tree' > 'Station' menu items.
 The elements of the 'Station' are listed.

4. Select module 101 or module 102 'CPU (FCC2001/06)'.

5. Press the 'MoreOptions' softkey and select 'Execute commands'.

6. Select the 'Reset module' command.
 The 'Station' shuts down.
 The 'Station' is switched off for several seconds.
 The 'Station' restarts.

PMI & mainboard FCM2004 and FCM2027

ϖ Switches S38-1 and S38-2 are set to the 'OFF' position on the PMI &
mainboard FCM2004.

κ On the PCB of the operating unit, press and hold down the 'S32' button for
<2 s.

 The 'Station' shuts down.
 The 'Station' is switched off for several seconds.
 The 'Station' restarts.
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↑ CPU card
1. Briefly press the 'S8' button on the CPU card until a 'R' is displayed on the LED

matrix display.

2. As soon as the 'R' is displayed, press and hold the 'S8' button for approx. 2 s to
confirm the selection.

 A checkmark on the LED matrix display confirms the selection.
 The CPU card is restarted.

You will find information on the ↑ CPU card FCC2004, the LED matrix display,
and operating the 'S8' button in document A6V10210368. See chapter 'Applicable
documents'.

10.8 Detailed commissioning steps
In the following chapters, you will find detailed commissioning steps that are
referred to in several chapters.

10.8.1 Preparing 'Station' for commissioning
1. Connect the cables for the ↑ detector lines and the peripheral devices.

2. Connect the power supply (mains and batteries).
 The ↑ 'Station' starts and reads in the internal hardware.
 During start-up, the 'FAULT' LED flashes and the display shows the

progress.
 During start-up, the firmware version F-FXS7211 is displayed.

3. Wait until the display indicates the selection of the ↑ BDV.

4. Press the 'Install' softkey and confirm with the 'Yes' softkey.
 The 'Station' restarts.
 During this process, the 'FAULT' LED flashes and the display shows the

progress.

5. Wait until only the green 'System On' LED lights up, the display shows the
normal condition, and the 'Station' can be operated.

6. Press <MENU> and select the 'Login/logout' menu item.
 You are prompted to enter a PIN.

7. Enter the PIN and confirm with <ok>.
 The 'User successfully logged in' message is displayed.
 The main menu is shown on the display.

8. Check the firmware of the 'Station' to ensure that it is up to date. To do this,
select the 'Topology' > 'Hardware tree' > 'Station' > 'More Options' > 'Show
details' menu items.
 The 'Station' version and configuration data are displayed.

9. Update the firmware if necessary.

10. Enter the date and time. To do this, select the 'Settings/administration' >
'System commands' > 'Set system time' menu items.

Additional messages may be displayed depending on the configuration of the
↑ 'Station'.



Commissioning
Detailed commissioning steps10

96 | 118
Building Technologies A6V10211100_f_en_--

Fire Safety 2015-12-15

10.8.2 Preparing 'Station' for commissioning –without BDV
installation
1. Connect the cables for the ↑ detector lines and the peripheral devices.

2. Connect the power supply (mains and batteries).
 The ↑ 'Station' starts and reads in the internal hardware.
 During start-up, the 'FAULT' LED flashes and the display shows the

progress.
 During start-up, the firmware version F-FXS7211 is displayed.

3. Wait until the display indicates the selection of the ↑ BDV.
 The 'Station' is prepared for commissioning.

It is not necessary to install the BDV for the further procedure. This saves having
to restart the ↑ 'Station'.

Following preparation, you can for instance perform the following steps, depending
on the selected commissioning variant:
● Initialize the ↑ 'Station'
● Auto-configure the 'Station'
● Load the configuration from the PC to the 'Station'

10.8.3 Auto-configuring 'Station'
1. Select 'Topology' > 'Hardware tree' > ↑ 'Station' in the main menu.

2. Press the 'More Options' softkey and select 'Execute commands'.

3. Select the 'Auto-configure station' command.
 The 'Station' is auto-configured.
 The following message is shown following successful ↑ auto-configuration:

'Command executed'
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10.8.4 Auto-configuring the detector line

NOTICE
Incorrect order for reading in a ↑ loop, no isolation of second 'Line'
Error when reading in a loop
The C-NET detector lines are detected as ↑ stubs during the first system startup,
e.g., 'Line' 11, 'Line' 12 (2-digit line number), even if they are connected as a loop.
● Before you proceed to reading in the first 'Line', you must isolate the second

'Line'.
● To read in a loop, always select the first 'Line', in this case 'Line' 11. 'Line' 12

is then read in automatically and a loop is displayed with a 1-digit line number,
in this case as 'Line' 1.

● Proceed in the same way from 'Line' 21/22 (loop 2) to 'Line' 41/42 (loop 4).

NOTICE
Overwriting an existing configuration
Parts of an existing customer-specific configuration are lost.
● First save an existing customer-specific configuration.

1. Select 'Main menu' > 'Topology' > 'Hardware tree' > ↑ 'Station' > 'Module' (line
card) > 'Line'.

2. Press the 'MoreOptions' softkey and select 'Execute commands'.

3. Select the 'Auto-configure line' command.
 The C-NET detector line is auto-configured.
 The following message is shown following successful ↑ auto-configuration:

'Command executed'
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10.8.5 Loading automatically created configuration to the PC

The description in this chapter only applies if a configuration has not yet been
loaded to the 'Station' and if the ↑ BDV was installed at the 'Station' after the
'Station' was started for the first time.

1. Select the 'File' > 'New site' menu item.
 The 'Create new site' window opens.

2. Select the 'Upload from station(s)' option field.

3. Click on 'Next'.
 The 'Create site by uploading from station(s)' and 'Connect' windows are

opened.

4. In the 'Connect' window, select 'Local connection' and then click on 'OK'.
 The configuration is loaded to 'Cerberus-Engineering-Tool'.
 The progress is displayed in the 'Create site by uploading from station(s)'

window.
 The 'Site properties' window is opened after loading.

5. Change the entries if required and click on 'OK'.
 The 'New site confirmation' window opens.

6. Click on 'Yes'.
 The 'Site' is opened in Cerberus-Engineering-Tool.

10.8.6 Adapting configuration
Adapt the configuration of the ↑ 'Site' in Cerberus-Engineering-Tool, e.g.:
● Changing customer texts
● Setting the properties and the parameter sets
● Changing allocation of 'Zones' and 'Sections'
● Configuring controls
● Configuring the operating and display units
● Configuring the network

You will find information on configuring an ↑ 'Site' in document A6V10210424.
See chapter 'Applicable documents'.
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10.8.7 Switch off

10.8.7.1 Safety during switch-off

WARNING

System parts that have been switched off make it impossible to acquire and
process alarms or faults!
Fire may spread unhindered.
● Deploy staff to monitor the deactivated area.
● You must switch deactivated parts of the 'Site' back on as soon as possible.

10.8.7.2 Switching off the detector line
1. Select 'Main menu' > 'Topology' > 'Hardware tree' > ↑ 'Station' > ↑ Line card >
↑ Detector line.

2. Press the 'MoreOptions' softkey and select 'Execute commands'.

3.  WARNING! System parts that have been switched off make it impossible to
acquire and process alarms or faults! Select the 'Detector line OFF' command.

 The yellow 'ISOLATION' LED lights up.
 The detector line is switched off.

10.8.7.3 Switch off zone
1. Select 'Topology' > ↑ 'Detection tree' > 'Area' > ↑ 'Section' > 'Zone' in the main

menu.

2. Press the 'More Options' softkey and select 'Execute commands'.

3.  WARNING! System parts that have been switched off make it impossible to
acquire and process alarms or faults! Select the 'Off' command.

 The yellow 'ISOLATION' LED lights up.
 The 'Zone' is switched off.

10.8.8 Switching on

10.8.8.1 Switch on detector line
1. Select 'Main menu' > 'Topology' > 'Hardware tree' > 'Station' > ↑ Line card >
↑ Detector line.

2. Press the 'MoreOptions' softkey and select 'Execute commands'.

3. Select the 'Detector line ON' command.
 The yellow 'ISOLATION' LED goes out.
 The detector line is switched on.
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10.8.8.2 Switch on zone
1. Select 'Topology' > ↑ 'Detection tree' > 'Area' > ↑ 'Section' > 'Zone' in the main

menu.

2. Press the 'More Options' softkey and select 'Execute commands'.

3. Select the 'On' command.
 The yellow 'ISOLATION' LED goes out.
 The 'Zone' is switched on.

10.8.9 Restarting the detector line

WARNING

Activation of fire or smoke dampers
If fire or smoke dampers are connected to the FS720 via an input/output module,
they may be activated when the station is switched off or when the station or
detector line is restarted.
● If necessary, block the outputs temporarily [➙ 101] before switching off the

station or restarting the station/detector line.

1. Select 'Main menu' > 'Topology' > 'Hardware tree' > ↑ 'Station' > 'Module' (line
card) > 'Line'.

2. Press the 'More Options' softkey and select 'Execute commands'.

3. Select the 'Restart line' command.
 The ↑ detector line is restarted. The following messages are displayed:

'Line starting up'
'Device config.runs'

Start line test
Only test the line and line devices once the following messages have disappeared
from the PMI:
- 'Device config.runs'
- 'System startup completed'
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10.8.10 Freezing outputs
You can freeze outputs with connected fire dampers to prevent them from being
activated if the 'Station' or line is restarted or in the event of a module reset. A
restart is required if a modified configuration is loaded to the 'Station'.

Duration of freeze
The output freeze lasts until the next restart or module reset. It is deactivated after
the restart or module reset. See chapter 'Enabling frozen outputs [➙ 101]' for how
to manually deactivate freezing.

ϖ All line devices are switched on.
ϖ Input/output modules with connected fire dampers are present on the line.
ϖ The output freeze is activated / configured in the ↑ 'Site' configuration. See

document A6V10210424.

1. At the 'Station', select the 'Station', a module, or a line in the hardware tree.

2. Select 'Execute Commands' > 'Freeze selected outputs ON'.

3. The 'Output positions frozen' message is displayed for the frozen outputs.
 You can now restart the 'Station' or the line or perform a module reset.

10.8.11 Enabling frozen outputs
ϖ One or more outputs have been frozen / the 'Output positions frozen' message

is displayed for one or more outputs.
ϖ All line devices are switched on.

1. At the 'Station', in the hardware tree select the 'Station', the module, or the line
that has been frozen or select the 'Output positions frozen' message for the
corresponding element.

2. Select 'Execute Commands' > 'Freeze selected outputs OFF'.
 Freezing of the outputs is deactivated.
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10.8.12 Read in devices on detector line
NOTICE
Incorrect order for reading in a ↑ loop
Error when reading in a loop.
The C-NET detector lines are detected as ↑ stubs during the first system startup,
e.g., 'Line' 11, 'Line' 12 (2-digit line number), even if they are connected as a loop.
● For loop with line separator: Switch the second 'Line' / 'Line' 12 off.
● To read in a loop, always select the first 'Line', in this case 'Line' 11. 'Line' 12

is then read in automatically.
A loop is displayed with a 1-digit line number, in this case as 'Line' 1 once it
has been read in.

● Proceed in the same way from 'Line' 21/22 (loop 2) to 'Line' 41/42 (loop 4).

ϖ For ↑ loop with line separator: The second 'Line' is switched off. Link [➙ 99]

1. In the main menu, select 'Topology' > 'Hardware tree' > ↑ 'Station' > ↑ Line
card > ↑ Detector line.

2. Press the 'More Options' softkey and select 'Execute commands'.

3. Select the 'Read in installed devices' command.
 The C-NET devices are read in.
 The following message is shown following successful reading in:

'Command executed'

10.8.13 Detaching the device
If you want to permanently remove a device, uninstall the device and, if required,
the base and connect the wires of the ↑ detector line.
You will find more information about installing and uninstalling in the
documentation for the corresponding device.

10.8.14 Delete the device on Person Machine Interface
1. Mark the corresponding device fault message.

2. Press the 'More Options' softkey.

3. Select the 'Show topology' menu item.
 The logical channel is displayed. For some devices, 'Device' is displayed

directly.

4. Press the 'More Options' softkey.

5. Select the 'Jump to link' menu item.
 The physical channel is displayed.

6. Press the 'Upper level' softkey.
 'Device' is displayed.

7. Press the 'More Options' softkey.

8. Select the 'Execute commands' menu item.

9. Select the 'Remove/delete device' command.
 The control panel deletes the physical representation of the removed device.
 The logical channel element remains in the 'Zone'.
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10.8.15 Remove the elements
If you have uninstalled an C-NET device for good, the corresponding elements,
e.g. the 'Cerberus-Engineering-Tool' must be removed from the logical structure
trees in Zone. You can search for elements using the 'Find' function.
You will find more information in document A6V10210424. See chapter 'Applicable
documents'.

10.8.16 Testing detectors
The commissioning personnel perform the function test for the ↑ automatic fire
detectors and the 'Manual call points'.

You will find additional information about the individual steps on the specified
pages.

ϖ The ↑ detector line has been commissioned.

1. Switch the test mode on. Link [➙ 104]

2. Initiate the detector. Link [➙ 103]

3. Switch normal operation on. Link [➙ 104]

4. Test the logged test activations. Link [➙ 103]

10.8.16.1 Activate the detector
ϖ DETECTOR TEST is switched on.

1. Activate all automatic 'Detectors' and 'Manual call points' using the
corresponding tools.

2. Write down the sequence of the test activations.
 The ↑ alarm indicator for the activated detector flashes at each test activation.
 If an ↑ external alarm indicator is connected and correspondingly configured,

the external alarm indicator also lights up.
You will find information about triggering detectors in document A6V10212047.
See chapter 'Applicable documents'.

10.8.16.2 Testing logged test activations
1. Test the logged test activations. This can be done in two ways:

– ↑ Person Machine Interface: Select 'Event memory' in the main menu.
– Cerberus-Engineering-Tool: Select the 'Commissioning' > 'Upload site

event memory' menu items.

2. Rectify existing errors if necessary, e.g., if the ↑ alarm indicator has not flashed
or no test entries exist.
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10.8.17 Switching on test mode
1. Select 'Topology' > ↑ 'Detection tree' in the main menu.

2. Select the element you want to switch to test mode: 'Area', 'Section', or 'Zone'

3. Press the 'More Options' softkey and select 'Execute commands'.

4. Select a command from the following table.
 The yellow 'DETECTOR TEST' LED lights up.
 The element is in test mode.

Element Command

Area ● 'Non-MCP zones det.test'
● 'MCP zones det.test'

↑ Section ● 'Non-MCP zones det.test'
● 'MCP zones det.test'

Zone ● 'Detector test'

10.8.18 Switch on normal operation

There is a shortened procedure for switching individual 'Zones' to ↑ normal
operation. The procedure is described in the following section: 'Switching 'Zone' to
normal operation'

Switching 'Area', 'Section' or 'Zone' to ↑ normal operation
1. Select 'Topology' > ↑ 'Detection tree' in the main menu.

2. Select the element you want to switch to normal operation: 'Area', 'Section' or
'Zone'

3. Press the 'More Options' softkey and select 'Execute commands'.

4. Select a command from the following table.
 The element is switched to normal operation.
 The yellow 'DETECTOR TEST' LED goes out.

Element Command

Area ● 'Non-MCP zones det.test END'
● 'MCP zones det.test END'

↑ Section ● 'Non-MCP zones det.test END'
● 'MCP zones det.test END'

Zone ● 'Detector test END'

Commands under 'Execute commands'

You can also switch to ↑ normal operation at superordinate level for the
command in question. Test mode can also be exited in the 'Zone', 'Section' or
'Area', for example.
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Switching 'Zone' to ↑ normal operation
There is a shortened procedure for switching individual 'Zones' to normal operation:

1. Select 'Message summary' > 'Test message' in the main menu.

2. Select the displayed 'Zone' in test mode and press the 'Execute Commands'
softkey.

3. Select the 'Detector test END' command.
 The 'Zone' is switched to normal operation.
 The yellow 'DETECTOR TEST' LED goes out.

10.8.19 Rectify localization errors
1. Use 'Topology' > 'Hardware tree' > ↑ 'Station' > ↑ Line card > Detector line to

select the corresponding ↑ detector line in the main menu.

2. Press the 'MoreOptions' softkey and select 'Execute commands'.

3. Select the 'Accept replaced devices' command.
 The fault messages are no longer displayed.

If devices are missing or the device types do not correspond to the C-NET
topology, error messages will continue to be displayed.

10.8.20 Checking 'Site' function
Test the function of the ↑ 'Site' in the various test modes.
You will find information on testing a 'Site' in the 'Testing' chapter of document
A6V10211076. See chapter 'Applicable documents'.

10.8.21 Carrying out final commissioning work
1. Check the date and time.

2. Adjust the date and time, if required.

– To do this, select 'Settings/administration' > 'System commands' > 'Set
system time' in the main menu.

3. Set the PIN for access levels 1, 2,1, 2,2, and 3.

– To do this, select 'Settings/administration' > 'Manage PINs' in the main
menu.

4. Fit the housing cover.

5. Label the installation plate, which should be outside on the housing, with the
site number and the date of commissioning.

– To do this, use a solvent-resistant pen.
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11 Remove or replace non-stationary C-NET
devices
If an C-NET device is removed, the loop contact prevents the C-NET line from
being interrupted and thereby prevents a fault message.
The work described in this chapter may be performed when the C-NET line is
switched on.

11.1 Temporarily remove an individual non-stationary C-
NET device
It may be possible that an C-NET device must be temporarily removed from the
base. Afterwards the same device must be re-inserted at exactly the same place in
the C-NET.

Procedure
1. Remove the device.
 The control panel detects that the device is missing and reports a 'Fault'.

2. Perform the necessary activities.

3. Re-insert the device in the C-NET in the same, previous position.

4. Acknowledge the 'Fault'.
 If the 'Fault' is no longer displayed, the control panel updates the settings of the

re-inserted device.
 If this 'Fault' is still displayed, and/or the 'Line' is not in normal operation, the

'Line' has to be restarted.
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11.2 Temporarily removing multiple non-stationary
devices
The procedure in this chapter applies both for the base with loop contact and the
base without loop contact.
For the purpose of painting work, it may be necessary to temporarily remove the C-
NET devices in a room. Each C-NET device must then be re-inserted in its original
base. The C-NET devices may not be exchanged.

Mark the allocation of the devices to the respective base to avoid additional work
steps.

You will find additional information about the individual steps on the specified
pages.

1. Switch the 'Zone' off. Link [➙ 107]

2. Remove the C-NET devices from their bases.

3. Perform the tasks.

4. Re-insert the C-NET devices to the respective position.

5. Switch the 'Zone' on. Link [➙ 108]
 For all the re-inserted C-NET devices, a localization fault is displayed.

6. Restart the C-NET detector line. Link [➙ 100]
If detectors have been swapped over or are missing, the following messages are
shown on the display of the Person Machine Interface:
'Zone', 'Serial no. ("ID-Nr.")', 'Dev.location fault'

The work described in this chapter may be performed when the C-NET detector
line is switched on.

11.2.1 Switch off zone
1. Select 'Topology' > ↑ 'Detection tree' > 'Area' > ↑ 'Section' > 'Zone' in the main

menu.

2. Press the 'More Options' softkey and select 'Execute commands'.

3.  WARNING! System parts that have been switched off make it impossible to
acquire and process alarms or faults! Select the 'Off' command.

 The yellow 'ISOLATION' LED lights up.
 The 'Zone' is switched off.
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11.2.2 Removing devices, performing tasks and re-inserting
devices

Mark the allocation of the devices to the respective base to avoid additional work
steps.

1. Remove the devices from their bases.

2. Perform the tasks.

3. Re-insert the devices to the respective position.

11.2.3 Switch on zone
1. Select 'Topology' > ↑ 'Detection tree' > 'Area' > ↑ 'Section' > 'Zone' in the main

menu.

2. Press the 'More Options' softkey and select 'Execute commands'.

3. Select the 'On' command.
 The yellow 'ISOLATION' LED goes out.
 The 'Zone' is switched on.

11.3 Permanently removing non-stationary C-NET
devices

You will find additional information about the individual steps on the specified
pages.

1. Switch the C-NET detector line off. Link [➙ 99]

2. Remove the C-NET devices and their bases. Link [➙ 102]

3. Switch the C-NET detector line on. Link [➙ 99]

4. Delete the C-NET devices individually via the Person Machine Interface on the
control panel. Link [➙ 102]

5. Connect the PC to the ↑ 'Station'. Link [➙ 77]

6. Load the configuration from the 'Station' to the PC. Link [➙ 82]

7. Remove the logical elements in Cerberus-Engineering-Tool. Link [➙ 103]

8. Load the configuration from the PC to the 'Station'. Link [➙ 80]

9. Disconnect the PC from the 'Station'. Link [➙ 77]
You can find information about the individual steps in the chapters referenced
below.
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11.4 Replacing non-stationary C-NET devices of the
same type
Procedure
● Switching on test mode
● Replace C-NET device
● Switch on normal operation
● Connect PC to the 'Station'
● Load configuration from the 'Station' to the PC
● Disconnect PC from the 'Station'
You will find information about the individual steps in the following chapters and the
chapters to which reference is made below.

11.4.1 Replacing the C-NET device
1. Remove the C-NET device you want to replace from the base.

2. Wait approx. 20 seconds.

3. Insert the new C-NET device of the same type.
 The internal alarm indicator flashes for 10 seconds following successful

replacement.
Proceed as follows if the alarm indicator does not flash:

1. Ensure that you wait long enough before inserting.

2. Check whether other C-NET devices are missing on the detector line.

3. Check whether a device that is not of the same type has been inserted. If this is
the case, insert a device of the same type.

4. Restart the C-NET line.
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11.5 Replacing non-stationary C-NET devices of
different types
Procedure
● Detach C-NET device
● Delete C-NET device on Person Machine Interface
● Installing a new C-NET device
● Read in C-NET devices. This step need only be performed once.
● Connect PC to the 'Station'
● Load configuration from the 'Station' to the PC
● Replace C-NET device in the 'Zone'
● Load configuration from the PC to the 'Station'
● Disconnect PC from the 'Station'
You will find information about the individual steps in the following chapters and the
chapters to which reference is made below.

11.5.1 Removing the C-NET device
κ Uninstall the device you want to replace.
 The 'Station' detects that the device is missing and reports a 'Fault'.
You will find more information about installing and uninstalling in the
documentation for the corresponding 'C-NET' device.

11.5.2 Installing the C-NET device
Install the new C-NET device.
You will find more information about installing in the documentation for the
corresponding 'C-NET' device.

11.5.3 Replacing C-NET device in the 'Zone'
1. Select the 'Zone' in which you have replaced a device in Cerberus-

Engineering-Tool. The 'Find' or 'Find and replace' functions can be used to do
this.

2. Replace the C-NET device.
You will find more information in document A6V10210424. See chapter 'Applicable
documents'.
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12 Testing the installation
The fire detection installation can be switched to 'Test' operation mode to check it
is functioning properly.

12.1 Testing
FS720 offers various test functions for efficient testing of devices and logical
functions. Some test methods can be combined, others have to be carried out
individually.
The fire detection installation is in 'Test' operation mode if one of the following test
modes is activated:
● 'Detector test'
● 'Walk test'
● 'Control test'
● 'Installation test'
● Test variants

You will find more information on testing the system in document A6V10211076.
See chapter 'Applicable documents'.
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12.2 Checking functions
The table below shows the recommended intervals for checking functions. National
specifications always take priority.
For details of the function test, refer to the 'Applicable documents' chapter.

Function Activity Interval
(years)

1 2 5

Software Check date and time. X

Detector lines:
● C-NET

Trigger an automatic detector and a manual call point per line. X

Trigger all manual call points  X

Trigger all automatic fire detectors.  X

Check all detectors for soiling and application. X

Check the function of the input/output modules.  X

On each line check whether short-circuit / open line triggers a 'Fault'.
Check the loop line function.
During short-circuit also check the separator function.

  X

Fire controls Check activation of the controls up to and with the interface.  X

Check isolations carried out by the customer. Arrange a time with the
customer.

 X

Degraded function  X

Mains failure Check 'Delayed for in case of a mains failure' function.

Alarm organization Check the function of the delay times t1 and t2. X

Alarm activation by automatic detector on 'unmanned'
⇒ Global alarm.

X

Alarm activation by manual call point on 'manned' and 'unmanned'
⇒ Local alarm/global alarm.

X

Check automatic switchover 'Manned' / 'Unmanned' on the basis of
the event memory entry.

X

Check activation of the remote transmission equipment with 'Alarm'. X

Actuate the corresponding danger level by activating a detector with
the detector exchanger and tester

X

Alarm devices In emergency power operation check all alarm devices taking the
event category into account:
'Pre-alarm'
'Alarm'
'Fault'

X
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Glossary
AI

Abbreviation for 'alarm indicator'.

Alarm indicator
Visual display to signal an alarm or pre-alarm.

Auto-configuration
A zone is created for each sensor channel
(automatic detector and manual call point). A
control is created for each alarm sounder. IO-
modules, FT2010, FT2011, and external alarm
indicators are not auto-configured.

Automatic fire detector
Device which measures a physical parameter
(e.g. warmth) in order to detect a fire.

BDV
Abbreviation for 'Base Data Variant'.
Configuration files for the embedded software. A
BDV contains country-specific templates, all
texts, specifications for message layout, menu
definitions, specifications for activating the LEDs
on the PMI, detector parameter set settings,
definitions for system-specific parts of the tool
interface, etc.

C-NET device
A device connected to the C-NET detector line.

CPU
Abbreviation for 'Central Processing Unit'. The
computing unit of the fire control panel.

Danger level
A fire detector signal which conveys the
possibility of fire. Automatic fire detectors, for
example, have danger levels 0 to 3. Manual call
points only have danger levels 0 and 3. 0 = no
danger, 1 = possible danger, 2 = probable
danger, 3 = highly probable danger.

Detection tree
Diagram of the geographical and organizational
arrangements of sensors in a building. This is a
hierarchical structure comprising the area,
section, and zone.

Detector line
Electrical connection between the detectors and
the fire control panel. There are collective
detector lines and addressed detector lines.

External alarm indicator
Optical element for displaying the fire location,
which is at some distance from the detector. It is
normally mounted in the room at the point where
the corresponding detector is accessible.

Line card
Card for connecting peripheral devices. The card
can be a plug-in card or it can be integrated into
the periphery board.

Loop
Detector line topology which runs from the fire
control panel via the fire detectors and back to
improve operational reliability. This type of wiring
allows all detectors to communicate with the
control panel even in the event of an open line or
short-circuit.

Normal operation
The fire detection installation is supplied with
mains voltage.

PMI
The arrangement of operating and display
elements on a fire control panel or on a fire
terminal. Includes the LEDs, buttons, the display,
and the operation options such as the key
switch, fire brigade control and display (FBA),
and the EVAC NL Person Machine Interface.

Pre-alarm
Stage before an alarm for information early on,
should an event occur.

Section
Level in detection tree of the fire detection
system. The section is assigned to the area. It is
used for combining zones.

Site
Depiction of fire detection installation: The top
level in the figure showing the installed system.
Combines hardware tree, detection tree, and
control tree.

Standalone station
Standalone station with local connection for the
PC.

Station
Unit for system control. Fire control panel or fire
terminal.
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Stub
Detector line which is only connected to the fire
control panel on one side. In the event of an
open line or short-circuit, it may no longer be
possible for all fire detectors to communicate
with the fire control panel.

Zone
Level in the detection tree. The zone has at least
one fire detector. The decision on alarm is made
at zone level. The zone is assigned to a section
or an area.
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